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Speedstack specifications

Maximum layer count
Via rules
Materials library

Post press compensation

Finished thickness
compensation

Cu thickness calculation
Board thickness calculation
User library

Save builds

64+
Conventional, blind and buried

Foils

Cores

RCC foils
Non-copper cores
Prepregs
Solder masks
Flexible cores
Bondply
Adhesive
Coverlays

Ident inks
Peelable masks

Yes (user defined)
Yes

Yes
Yes
Yes
Yes
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Personal computer requirements

Computer IBM PC compatible
Processor Pentium 1GHz or better
Operating system Windows 7 or later
Environment Requires .NET Framework v2.0 or above
System memory required 2GB recommended
Hard disk space required 200MB (min.)
Video standard HD 1080 (1920 x 1080) or higher
Hi color 16 bit or higher
Licensing Electronic: local FlexNet license

Fixed: Parallel/USB key

Floating FlexNet licence
(Windows servers only)
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Guide to the manual

Introduction

Getting started with
Speedstack

Configuring Speedstack

Using Speedstack

Design rule checking

Adding controlled impedance
structures

Si Projects

CITS test files

Speedstack Flex

Speedstack HDI

The Speedstack Materials
libraries

Printing stackup reports

Introduces Polar Instruments Speedstack.

Steps through the process of creating a simple stack
from a set of manufacturer's data.

Setting up the Speedstack environment including
license options, crosshatch and structure defaults, goal
seeking parameters and file locations.

Discussion of the Speedstack user interface; creating
and editing stackups.

Using Virtual Material mode; using Material Library
mode

Using the Speedstack Design Rule Checker to correct
stackup design errors.

Working with the Si8000m/Si9000e field solvers to add
controlled impedance structures to the stackup model.
Using the goal seeking facilities of the field solver to
obtain the correct impedance for a structure.

Working with Si Projects in Speedstack with Si8000m
and Si9000e

Creating CITS test files for controlled impedance
structures in the stack

Working with flex-rigid stackups — using the Speedstack
Flex navigator

Working with HDI builds — sequential lamination

Using the Speedstack materials libraries, creating new
libraries, adding material to the library.

Printing Speedstack technical reports; using the stack
data tables, drill data tables, controlled impedance data
tables, bill of materials tables
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Introduction to Speedstack

Speedstack PCB Stackup Builder

Polar's Speedstack PCB Stackup Builder is designed to
accelerate the PCB stack design process and deliver
significant reductions in the amount of time consumed in
PCB stackup documentation and control. Given designer
specifications the PCB fabricator can use the Speedstack
Stackup Builder to create in just a few steps the most cost
effective stack for the range of available materials.
Speedstack offers interconnect designers (PCB layout
engineers), PCB front-end engineers and fabricators a fast
and professional solution to layer stackup creation.
Speedstack provides formal documentation for everyone
involved in ensuring the correct materials are used in the
build process.

Speedstack PCB

Speedstack is a versatile PCB layer stackup design tool
featuring powerful and easy to use graphical stackup editing
capabilities. For PCB fabricators Speedstack PCB interfaces
with the industry standard Polar Si8000m PCB Controlled
Impedance Field Solver. It includes a link and license for
Polar’s Si8000m, using the proven Polar Si8000m multiple
dielectric boundary element field solver to provide the
impedance data for the stack. In addition, Speedstack PCB
licence holders have full access to the stand alone Si8000m
Quick Solver licence.

Speedstack PCB is especially tailored for PCB fabricators
and PCB brokers — anyone with a requirement to design or
communicate controlled impedance PCB stackups.

Speedstack PCB customers are able to share stackups and
read impedance requirements from designers who are using
Speedstack Si.

Speedstack Si

For electronic engineers involved in stackup design
Speedstack Si interfaces with the Polar Si9000e PCB
Transmission Line Field Solver.

Both Speedstack Si and Speedstack PCB are able to directly
output controlled impedance test files associated with each
stackup. For the fabricator this is an ideal way to link the
iImpedance test requirements to a particular job. For the
OEM this offers a clear method of sending impedance test




specifications out to suppliers or brokers. Designers and
fabricators can work together and select the best material
combinations for minimising build costs. Fabricators can
share their in house material libraries with OEMs and ensure
the most effective material choice is employed in the build.

Speedstack Flex

Speedstack Flex allows OEM designers to create accurate
and efficient flex-rigid PCB stackups in just a few minutes,
with error-free documentation for tighter control over the
finished board. For PCB fabricators, Speedstack Flex
provides the flexibility to quickly calculate the impact of
substituting alternative materials to improve manufacturability
and reduce cost while maintaining the specified parameters
and performance of the board. Speedstack Flex can be used
in conjunction with the Si8000m and Si9000e field solvers
when modelling and documenting mesh/crosshatch ground.
Structure data and mesh geometry can be readily shared
between Speedstack and the field solvers. The Navigator
provides a clear contextual view of the rigid and flexible
stacks within a flex-rigid build and allows easy alignment of
displayed materials between stacks. The associated
technical report also supports different materials on the same
dielectric layer, improving the clarity of documentation
between the stackup designer and fabricator.

Speedstack HDI

Speedstack’s Navigator quickly guides you through the
sequential sub-stack lamination sequence and presents the
complete assembly in a parsed graphical display that shows
each phase of the multi-step lamination sequence of an HDI
PCB. There is no limit to the number of press cycles that can
be documented. User-definable settings within the navigator
allow engineers to display layers in transparent, invisible or
3D mode. Speedstack HDI makes re-ordering and renaming
sub-stacks quick and easy with the Navigator. This is
especially useful for HDI constructions.

Rapid stackup creation

Users may specify the stackup semi-automatically with the
powerful Stackup Wizard or alternatively build the stack
manually, layer by layer. Speedstack is flexible and allows
full manual editing of stacks created by the Stackup Wizard.

Easy stackup editing

The Speedstack allows the user to view stackup in 2D or 3D
format. Layer and material annotation is clear and easy to
read and each layer may be selected and queried to display
the associated material type and properties, including the
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associated data file. Visible drill information ensures that
designers instantly know which layers support conventional,
blind and buried vias.

Speedstack allows you rapidly to build and share stacks and
verify via aspect ratios and track spacing rules. The stack file
contains base material information combined with layer
description and a complete listing of transmission line
structures deployed in the stack. Keeping all stack
information in one file ensures that manufacturing data is
accurately shared between original designer and fabricator.

Speedstack’s Stack Editor provides efficient and time-saving
features such as Copy/Paste Material properties so the stack
designer can copy all properties from a selected material and
then paste user-selectable property groups to other materials.

Speedstack allows the designer to retain and re-allocate
structures when changes are made to the electrical layers of
the stackup. This enables reallocation of structures after the
following stackup changes:

Adding and deleting foils and/or cores — increasing or
reducing the layer count

Moving foils and cores, — maintaining the layer count
Exchanging two different thickness cores within the stack

Copying and pasting foils or cores — increasing the layer
count

High quality documentation and file format

Speedstack saves the stack in efficient electronic format and
outputs stack graphics in a variety of formats to suit your
requirements. Stack data may be output in GERBER, DXF,
BMP, JPEG, TIFF and XML. In addition, the stack data can
be exported in comma-separated form for inclusion in other
systems. Speedstack’s high quality customisable printouts
make it easy to discuss alternate builds and pricing impacts
with fabricators.

Applications engineers, front end and production engineers
benefit from receiving stack information in an intuitive, easy
to understand format. The Speedstack .sci file contains full
details of the layer stackup of a particular job. If changes are
necessary or preferred stacks are to be shared with
customers, Speedstack can cut the time for documentation
and information sharing to a fraction of the time taken when
employing traditional methods such as spreadsheet, word
processor or presentation software.
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Integration with the Si8000/Si9000

The Speedstack is fully integrated with the Polar Si8000m
Controlled Impedance and the Si9000e PCB Transmission
Line Field Solvers so the user can quickly add controlled
impedance structures to layers in the stackup. The designer
or board fabricator can use the Goal Seek facility of the
Si8000mM/Si9000e field solvers to arrive rapidly at the
controlled impedance structure parameters to produce the
target impedance.

Materials library

The Speedstack supports a flexible materials library. This
allows the designer to use standard materials data and also
provides the facility to create new material libraries. PCB
fabricators can also build libraries of commonly stocked
materials to give interconnect designers visibility of the
materials held in stock. Speedstack thus supports three
types of library — custom user libraries of materials, generic
designer libraries of materials of given dielectric
characteristics (for example, thicknesses) along with a
comprehensive set of materials libraries from PCB base
material suppliers who are members of the Polar Speedstack
Material Partner program.

Speedstack's Virtual Material mode

Speedstack provides Virtual Material mode allowing you to
build and experiment with stackups (for example to examine
the effects on impedance structures of different trace widths
or dielectric heights) without requiring real materials to be
entered into a materials library.

In Virtual Material mode you will use the Stackup Wizard to
enter a few details about the stack, the number of layers,
overall board thickness, plane and mixed layers, etc., along
with solder mask and copper thickness and build type (foil,
core or HDI.) and drills Speedstack will then build a stack to
the specified board thickness by equally distributing the
dielectric regions. If a preferred core thickness is specified
the software will maintain the dielectric thickness for core
regions but then equally distribute prepreg regions to reach
the target board thickness.

Preferred builds

PCB fabricators are able to create and share preferred builds
and exchange the associated information with designers.
Build data also includes blind and buried via specification.
This simplifies the task of sharing stackup and drilling
information between board shops and the design community.
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Dimensional information

Finished board thickness is a critical dimension in many
applications; Speedstack keeps track of the finished PCB
thickness and tolerance and allows fabricators the flexibility
of adding in-house post-press thickness for prepreg layers.
Additionally, Speedstack takes into account plating thickness
where appropriate.

High layer count boards

On boards with high layer counts it can be very easy to make
a change that would produce a non-symmetrical stack. The
Speedstack Design Rules Check monitors symmetry across
the stack, and ensures that material symmetry is maintained.
Speedstack also makes it easy to set the symmetrical build
mode to ensure that any changes you make are applied
equally across the stack.

Supplier management

When multiple-sourcing PCBs or when moving from
prototype to volume production, the stack and fabrication
design rule checks ensure that the manufacturing capabilities
of your chosen suppliers are not overlooked. In addition the
professional documentation output ensures that layer stack
information is accurately conveyed to PCB suppliers.

Graphical interface

Speedstack offers an easy to interpret graphical interface.
Clearly showing the layers supporting blind and buried vias,
Speedstack also records the data file for each layer
(including ident and peelable mask layers). The graphical
interface is especially designed to simplify the process of
communication between interconnect designer and
fabricator. OEMs who need to manage boards sourced from
multiple suppliers will also find this facility invaluable. In
addition to physical layers Speedstack adds mask and
notation for electrical layers.

Interfacing with other systems

Speedstack is able to load an XML file on launch. If an XML
file (.stkx) filename parameter is specified on the command
line it will import this file into Speedstack.

Speedstack can call an external program / utility / script via
the External Utilities menu options. The menu items are
configured within the Configuration option.

Importing and exporting stackup information

Speedstack incorporates the facility to read in files in XML
format and Ucamco Job File format. Speedstack provides
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comprehensive integration with Ucamco and will import files
from and export to both Ucam and Integr8tor.

Speedstack integrates directly with the Zuken DFM Center
PCB manufacturing pre-processing and CAM system.

Stacks may be exported to the Polar CGen Coupon
Generator for subsequent processing into test coupons.

The Export CITS File option will create test files for Polar
CITS controlled impedance test systems.

Speedstack can generate printed output in DXF, Gerber,
CSV and XML, as well as graphic image formats JPEG, BMP
and TIFF.

Export options also include Cadence Allegro, CSV, IPC-2581
Rev B and Mentor Graphics.

Structure net classes

Speedstack is able to import and store up to five net class
names with each structure. These net class names provide a
link to the matching impedance nets inside the ECAD PCB
layout system.
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Installing Speedstack

Installing and activating Speedstack

It will be necessary to install and activate the product license
and set operating options prior to building stacks or
performing calculations with Speedstack. See Configuring
Speedstack]Licensing to select the associated field solver
and purchased options.

Contact Polarcare@polarinstruments.com for
installation/activation directions.

Download the software from the supplied link. Unpack and
save the installation file to a suitable folder then run Setup.

Uninstalling the software

Caution: Prior to uninstalling, make a copy of the Speedstack
folder structure and store in a safe place.

To uninstall the Speedstack software:

Windows XP

Click the Windows Start button and choose Settings and
Control Panel. Double-click Add/Remove Programs and
choose Speedstack from the list. Click Remove.

Windows 7/8/10

Choose Settings|Control Panel; select Programs and
Features and right click Speedstack and choose Uninstall.

Getting started with Speedstack

Online tutorial guides

Polar’s web site provides online downloadable quick start
and version specific user guides to familiarize users with the
operation and features of the software.

From the Help menu choose Speedstack Help to download
the Getting Started guide, along with tutorials for stack
editing, managing materials libraries, manufacturing
constraints and controlled impedance structures:

http://www.polarinstruments.com/help/speedstack/tutorials/

Download the user guide for your Speedstack version:
http://www.polarinstruments.com/help/speedstack/Nrmstart.htm
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Using Speedstack Stackup Builder

Speedstack Stackup Builder

Double-click the Speedstack icon to start the Speedstack
program and display the Stack Editor.

The Stack Editor

The Stack Editor screen displays all details of the stack,
including copper and prepreg materials, solder masks and
ident layers, drilling information, controlled impedance
structures and design rule check results.

Controlled impedance structure data may be transferred
between Speedstack and the associated Polar Si8000m or
Si9000e field solver to goal seek for the target structure
dimensions.

3E Polar Speedstack PCB Stack Up Builder:  Stack: Eval Imperial LT.stk  Project : Eval Imperial LT sci - O X

File Edit View Tools Units External Utility Help

777 LT k6 5D i E0

Stack Up Edtor | DRC: 0 Controlled Impedance | C1 Resuts |

EesdTO=S0XO ===

X XOEglEL o
a || <frota  5]a

4.000

Substrate 1 Height
Substrate 1 Dielectric
Lower Trace Width
Upper Trace Width
Trace Separation

Trace Thickness
Coating Above Substrate
Coating Above Trace
Coating Between Traces
Coating Dielectric

Differential Impedance Zd |[100.35
Target Impedance 100.00
Target Tolerance % 10.00

19

0.700

4.000

[Wils/Thous  [Target Stack Up Thickness = 60.0000 | Stack Up Thickness = 59 4600 [Stack Up Thickness with Soldemmask = 614600 |V 16.01.20746

The Stack Editor screen

The Speedstack Stack Up Editor screen comprises:

e The Menu bar — drop-down menus containing all the
Speedstack Editor commands

e The Tool bar — incorporating short cut tool buttons to
the most common menu commands
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The Stackup Build and Construction Window — where
the board stackup is built and edited

The Controlled Impedance window displaying the
controlled impedance structures (if any) for the
selected layer.

Stack Up Editor/Notes tab— a free form text area for
explanatory or commentary notes

Design Rules Check (DRC) tab — allows design rules
and manufacturing constraints to be specified and
violations displayed

Stack Up Information properties area — table
containing information related to the whole stackup

Selected Item Information area — properties table
containing the attributes of the layer currently selected
in the stackup

The Speedstack menu system

The File menu

The File menu allows for creation of new stackups and
projects and opening, saving, printing, importing and
exporting existing stackups and projects.

e

| New | Stackup Wizard Ctrl+N
Open Project Ctrl+ 0 Empty Stackup  Ctrl+5Shift+M
Open Stack Ctrl+5Shift+ 0
Search Ctrl+F
Save Project Ctrl+5
Save Project &z Ctrl+5Shift+5
Save Stack
Save Stack As
Export 3
Import 3
Print 3
Properties Ctrl+|
Recent Files 3
Exit Ctrl+

Opening projects

Stackups that incorporate controlled impedance structures
are saved as projects. Click Open Project and navigate to
the project folder; projects are saved as .sci files. The
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stackup along with all its design rule checking settings and
controlled impedance information is loaded.

Saving stackups

Click the Save button to save the stackup. Users are
recommended to save the stackup frequently during the
stackup creation process to avoid data loss; stackups are
saved as .stk files.

Saving projects
Use the Save Projects command to save a stackup and its
controlled impedance structures.

Searching for stackups and project files

When creating new stackups and projects it will often be
found convenient and timesaving to reuse an existing stack
or project, modifying as required and the saving as a new
stack or project. From the File menu choose Search and
click Change Folder to navigate to the collection of stacks.

§§ Select Search Folder(s) - O x

File Types

Stack (.stk)

Stack with Controlled Impedance (.sci) [v

Default Path
C:\Program Files (x36)\Polar'Speedstack\Samples

Change Folder

Search Sub Folders v

Apply | Cancel |

Y.

Choose from stacks and/or projects (stacks with controlled
impedance;) with the folder chosen, click Apply.

Supplying search criteria

The stackups and projects within the chosen folder structure
are displayed. If appropriate supply criteria, layer count,
board thickness, etc. and click Filter.
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85! Search Existing Stackup Files — O =

r—Filter

Layer Count r Number Of Layers Ig

Board Thickness r Minimum Thickness Iﬂ Maximum Thickness Iﬂ

Clear Filter | Fiter |

Mumber Of Layers | Actual Thickness | Flanes | 0.50z/18microns | loz/35micrens | Zoz/7TOmicrons | File Name | Fil =]
12 593 2,57 11 1234586738 Doublet-2 sci il
12 59.3 2,57 11 1,23 456,738 Doublet-Simple.sci cy
12 598 2,57, 11 1.2,3.4586738 FlexRigid_12Layer_Stepl.sc C:l
12 88.1496 4679 Qualcomm v14 test.sci cAl
10 6377 3,568 1.2,9.10 345678 10-layer-sequentiallam-mil-i  C:|
10 62.9724] 3,568 1,2,9.10 345678 10-ayer-sequentiallam-mmri C:il
10 42 5197 31568 1.2.3,4567.8 AP523_HD sci il
10 60 8582 3568 1,2,910 345678 fred sci c
10 60 8582 31568 1.2.910 345678 HDI_PressCycles_mm_CuFi C:l
10 60 8582 1568 1,2,910 145678 testsci c
2 646 45 1.8 234567 B-Layer-sample sci CAl
2 626772 16 2367 AP528-real sci cil
o CYRQOA 7 C ADRTI0 VAR mmi [ati)

<« | )I

Target \Value | Upper Signal Layer |Sing|e Ended | Differential |Cop|anar | Broadside |Trace ‘whidth |Traoe Thickness
» |50 1 cd I I r 12 0.7087
100 1 r v I r 8 0.7087
% 4 4 r r r s 1378
100 4 - v r - 4 1.378
50 7 Ird I I r [ 1378
100 7 - v r - 4 1.378
50 10 v I I r 12 0.7087
100 10 r [¥ I r 8 0.7087
Cancel Load File
A
Step through the list, choose the matching stack or project
and click Load File.
Importing Stackup information
Speedstack incorporates the facility to read in files in:
Ucamco Job File format
XML format
Zuken CR-8000 format
Ucamco Integr8tor and Ucam format
Import r m Ucamco Job File r Import
XML File (.stho Clear Rules
Zuken CR-2000

Uecameo Integrdtor and Uecam (i5sx)
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Ucamco Job Files

The .Job file format contains a varying amount of stackup
information depending upon the how the system has been
configured by the Ucam user.

Speedstack will import files from both Ucam and Integr8tor.

Choose File|]lmport|Ucamco Job File|iImport and select the
Job file and click Open. The Ucamco .Job File Import dialog
is displayed:

Ucamco Job File Import

Please map each .Job layer / drill class assignment to the equivalent
Speedstack material type:

1. Select a class from the right-mast list
2. Click the button to nominate the material / layer type

~.Job Extra Assignments
Solder Mask | | |
Idents | -]
Peelables | | |
~.Job Layer Assignments
Signal | |
Mixed | |
Power | | =]
Hatched | | -]
Job layer classes that are unassigned will be imported as Signal
~Job Drill Assignments
|| X | =
Plated | | |production
Nonplated | | -]
Reset Apply | Cancel

The .Job file contains user-definable material / drill class
definitions so it will be necessary to map these definitions to
the various Speedstack material and drill types.

12 e Speedstack PCB Stackup Builder



To apply assignments select the class from the drop down
list then click the associated button to nominate the material
or layer type. Click Apply.

Note: Where stack data are not included in the .job file it will
be necessary to include or update properties (for example,
solder mask properties such as thickness and dielectric
constant) before adding impedance structures.

Integr8torJob files
When Integr8tor files are imported the Ucamco .Job File
Import dialog is displayed as shown below.

Ucamco Job File Import

Flease map each Job layer / drill class assignment to the equivalent
Speedstack material type:

1. Select a class from the right-mast list
2. Click the button to nominate the material / layer type

~Job Extra Assignments
Solder Mask | | -] == -]
e || s
Peslables | | -l
~Job Layer Assignments
Signal | R I outer |
Mixed | | P
over | <
Hatched | | |
Job layer classes that are unassigned will be imported as Signal
—_Job Drill Assignments
Laser | ~| [EE -
Plated | | rout
Nonplated | | |
Reset ey | Cancel
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Select the assignment options as described above and click
Apply. Click Reset to clear the assignments.

Clear Rules

The Clear Rules command will delete all previously learned
rules.

XML files
Choose File|lmport|]XML File (.stkx), select the .stkx file for
import and click Open.

Zuken CR-8000
Choose File|lmport|Zuken CR-8000 format, select the .stkx
file for import and click Open.

Ucamco Integr8tor and Ucam format (.Ssx)
Choose File|lmport|Ucamco Integr8tor and Ucam format,
select the .ssx file for import and click Open.

Exporting stackup information

Speedstack incorporates the facility to export stack data to
external programs. From the File menu choose Export To
and choose the format from the Export To sub-menu.

Coupon Generator (CGen)
CITS File

DxF

Gerber

Stackup lmage

Cadence Allegro
C5V...

IPC-2581 Rev B
Mentor Graphics
EML File (.sth)
Zuken CR-2000
Zuken DFM Centre

Ucarnco Integritor and Ucarmn (.s5%)

Exporting to Coupon Generator (CGen)

Stacks may be exported to the Polar CGen Coupon
Generator for subsequent processing into test coupons. Click
Export To|Coupon Generator — open the file in CGen.
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Export CITS File

Use the Export CITS File to create test files for Polar CITS
controlled impedance test systems. Supply board details via
the Board Details dialog.

Board Details

Customer [>(Z Boards
Board Type |Main Controller
Part Number [MC 1234
Revision Number |Re\-’ M

MNotes

MakeFiIe| Cancel |

Click Make File to generate .cif files (CITS test files).

Generating printed output

Speedstack can generate printed output in DXF, Gerber,
CSV and XML, as well as graphic image formats.

DXF, Gerber, CSV and XML files
Choose DXF..., Gerber..., CSV... or XML File and navigate
to a suitable folder, name the file as appropriate and save.

Stackup images
Speedstack can export stackup images in JPEG, BMP and
TIFF file formats. Select from 2D or 3D displays.

iE Export StackUp Image
Output Selection Format
% Flex-Rigid Overview (41l Stacks) ' JPEG " BMP £ TIFF
" Current Stack Shown in Editor
Low Quality High Quality
Mode J
g el 100%
Output Path and Filename
Path
Savefile |  Cancel |

The Low Quality — High Quality slider specifies JPG quality.
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Choose the Flex-Rigid Overview (if appropriate) to display
the master stack and associated sub-stacks or Current Stack
Shown in Editor. Specify the destination folder and file name
and save.

IPC-2581 Rev B

Speedstack supports reading/writing in IPC-2581 Rev B
formatted data. Choose the IPC-2581 Rev B option and
supply the file name and destination folder

Ucamco Integr8tor and Ucam

Choose the Ucamco Integr8tor and Ucam option and supply
the file name and destination folder. (Note the .ssx file
extension.)

Zuken DFM Centre

The Zuken DFM Center PCB manufacturing pre-processing
and CAM system integrates directly with Polar Instruments’
Speedstack PCB system. Navigate to a suitable folder and

save the file (XML format).

Assigning properties to projects and stackups

The stack file Properties dialog may be displayed
automatically each time a new stackup is created (see
Tools|Options|General) and provides a range of text fields for
descriptive information, e.g. stackup author, company name,
file create date, stackup name, version, etc.

From the File menu choose the Properties command to add
descriptive text fields — information contained in the
Properties dialog will be displayed on stackup printouts.

To display the Properties dialog each time a new stackup or
project is created, from the Tools menu choose Options and
click the check box below on the General tab

‘W Dizplay File Properties Dialog for New Stackups and Projects ‘

Backing up stackups and libraries

It is strongly recommended that stackup files (assigned the
.Stk extension), project files (assigned the .sci extension) and
library files (assigned the .mlbx extension) be backed up to a
secure location.

Opening recent files
Click Recent Files to select and open a file from the most
recently used file list.
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The Edit menu

Edit
| Add v Foil
Add Cl Structure Core
Delete Del RCC
Swap Ins Mon Copper Core
Frepre
Copy Ctrl+C e
Solder Mask
Paste Above Ctrl+W
Paste Below Ctrl+Shift+V Flex Core
) . Bondply
Properties Ctrl+ Shift+I
Adhesive
Set To Signal Coverlay
Set To Plane Ident
Set To Mixed Peelahle
Set To Hatched
Drrill
Hatch Profile
Move Up Ctrl+Up
Mowve Down Ctrl+ Down
FlexMav Mowve Up Ctrl+5Shift+Up

FlexMav Move Down Ctrl+ Shift+ Down
Undo Ctrl+Z
Redo Ctrl+Shift+Z
Set Stack Default Colours

Rezet All WVDP Attributes

The Edit menu contains the commands necessary to create
and modify board stackups. The designer or fabricator works
within the free-form stackup build and construction window
and in Materials Library mode adds layers of foil, core,
prepreg, etc., from the materials library.

Speedstack provides the option to switch easily between
Material Library and Virtual Material modes allowing the
stack designer to build and experiment with stackups (for
example to examine the effects on impedance structures of
different trace widths or dielectric heights) without requiring
real materials to be entered into a materials library.

Controlled impedance structures can be added to the stack.
When Add CI Structure is selected Speedstack switches to
the Controlled Impedance pane and allows the designer to
add structures appropriate for the selected layer. The items
that can be edited depend upon whether the Stack Up Editor
or Controlled Impedance tab is selected.
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Layers can be changed to signal, plane, mixed or hatched,
moved up or down or copied and pasted, or assigned
properties as required.

Use the Delete and Swap commands to delete materials or
swap materials from the Materials Library.

The View menu

Use the View menu to change the Stack Editor display whilst
adding or removing materials or modifying or refining the

stack.
View

20 View Ctrl+5Shift+2
30 View Ctrl+5Shift+3
Zoom In Ctrl++
Zoom Cut Ctrl+-
Zoom Extents Ctrl+0
Default View Ctrl+%
Open Mavigator F4

Restore Mavigator
Proportional Stack Viewer  F3

Open Material Library  Ctrl+L

Open User AppData Folder

The View menu allows Speedstack to display the stackup in
a 2-dimensional or 3-dimensional aspect.

Zoom In to get a close-up view of the stack or Zoom Out to
see more of the stack at a reduced size. Zoom Extents will
adjust the zoom level to display the whole stack.

Hint: Click the mouse centre button/wheel to Zoom Extents.

With the Flex / HDI option installed choose the Open
Navigator command to view the master and associated sub-
stacks. The floating Navigator window may get covered by
other application windows when switching between
programs; — use the Find Navigator to display a reduced
Navigator window at the top left screen corner.

Use the Proportionial Stack Viewer to display the stack
currently selected in the Stack Editor so the material
thicknesses are shown proportional to each other. This can
be informative as a visual aid, especially when considering
the dielectric thicknesses between electrical layers.
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The Tools menu
Use the Tools menu to configure Speedstack.

Tools |

Opticns Ctrl+Shift+0
Manufacturing Constraints Ctrl+ M
Set Finishing Metheod Ctrl+M

Set Target Stackup Thickness / Enable Finishing  Ctrl+T

Virtual Material Made Ctrl+5Shift+Y

Language 3

The Options command displays the configuration options,
manufacturing constraints, target stack thickness and
finishing options. See Configuring Speedstack for details.

The Units menu

Use the Units menu to select the stackup units, Microns,
Mils/Thous, Millimetres or Inches

Units

Microns Shift+F1

Mils/Thous  Shift+F2

Millimetres  Shift+F3
Inches Shift+F4

External Utility

Use the External Utility commands to start a program
external to Speedstack. The programs are defined in the
Configuration Options|External Ulilities dialog.

The Help menu

Use the Help menu commands to access the User Guide for
the current Speedstack version or tutorials relating to
common Speedstack operations.

Review the licensing terms with the License and About
Speedstack commands.
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Configuring Speedstack

When first run, the Speedstack environment is initialised to
its factory settings. These may require adjustment before
outputting a finished stackup and/or project. Default settings
are changed using Tools|Options, Tools|Manufacturing
Constraints and Tool|Set Finishing Options.

Environment and default settings
From the Tools menu choose the Options command to

display the Configurations Options dialog.

General Options

Default Stack Up View Display Data
© an Display Fields 1 and 2 are reserved for Layer Numbers and Layer Types
| Display Field 3 |Display Field 4 | |Display Field 5
“ 3D |Descriptiu:|n hd |N|:|ne ﬂ ||5|:|Iaﬁ|:|n Distance hd
Units
" Mils/Thous {* Microns " Millimetres " Inches

[v Open last used file on application start up

[v Display File Properties Dialog for Mew Stackups and Projects

Choose the Default Stackup View — 2D or 3D; select the data
fields that will appear alongside the stack in the Stack Editor

| Display Field 3 [Display Field 4 | [Display Field 5
|Des-:ripti-:nn - |Nu:une j |Base Thickness [
Supplier Finished Thickness
Supplier Description Basze Thickness Copper Coverage
E&h Finished Thickness |zolation Distance
Stack Mumber Copper Coverage Diglectric Constant
Type Izolation Distance Resin Contert

Diglectric Constant Tg

Resin Contert Colour

Tg ¥ | | Data Filenames il

Choose the stackup units; Speedstack supports Mils/Thou,
Microns, Millimetres and Inches. Click the Open last used...
check box to specify that Speedstack should open the last
used file on start-up.

Note: Processed Thickness is the Finished Thickness for
copper layers and Isolation Thickness for dielectric layers.
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Clicking the Display File Properties Dialog... will display the
File Properties Dialog each time a new stackup or project is
initiated.

Structure Defaults

Structures Board Thickness

W1 Default Trace Width [15000

W2 Default Trace Width [12500 Board Thickness 160000
G1 Default Trace Width [15000 Pus % [0
G2 Default Trace Wwidth 12500 Minus % [10
51 Default Trace Separation W

01 Default Trace Separation W Drilling

01 Default Trace Offset oo Minimum Hole Size EET—
REr Default Resin Puddle Er "

When adding new controlled impedance structures default
values are entered for the trace widths and separations. Use
the Structure Defaults tab to specify the default structure
parameters, board thickness and minimum drill hole size.

Licensing

" Mo License
(" Use Polar Si8000m License

{* |lse Polar Si3000e License

If Polar Si8000m or S13000e has been purchased and you wish for
interactivity between Speedstack and either of these products,
zelect the appropriate license.

[v¥ Speedstack Flex/ HDI License (SF)
[v¥ Hatch Mode License (XFE)
Iv¥ Speedstack Import / Export License (10)

¥ Speedstack / Ucamco Integration License (UCAMCO)

Use the Licensing tab to tick the purchased licensing options.

To activate the Speedstack controlled impedance function,
ensure that the Si8000 or Si9000 is installed; from the
Licensing tab choose either Use Polar Si8000m License or
Use Polar Si9000e License option as appropriate.
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Choosing default file locations

Select default matenals library file

C:\Program Files (x86)\FPolar\Speedstack\Samples\Speedstack Impenial mibx Browse. .

Select default folder to store Stack Up (" stk) files

C:\Program Files (x86)\Polar\Speedstack\Samplest Browse. ..

Select default folder to store Matenial Filter (7 mif) files
C:\Program Files (x86)\Polar\Speedstacki\Samples'\Filters Browse. .

gy

Use this dialog to choose which materials library the
Speedstack uses at start-up. Click the File Locations tab and
use the Browse button to navigate to the library (.mlbx) file.

The File Locations tab provides for default locations for
stackup or project files and Material Filter (.mlf) files. Browse
to the target folders and click OK to confirm (create new
folders if necessary).

Specifying goal seeking parameters
Click the Goal Seeking tab to specify the default values for
trace widths and separations used during goal seeking.

1 Maximum Trace Width W Comvergence ’I}E-['.'i
W1 Minimum Trace \Width W Maximum lterations "Il}i
51 Maxamum Trace Separation W
51 Minimum Trace Separation W
01 Maximum Trace Separation IW
01 Mimimum Trace Separation W
H Maximum Value W
H Minimum Value W

During goal seeking the calculated value for impedance will
progressively converge upon the target value. In the
Convergence text box specify the difference between the
target impedance and the actual impedance at which goal
seeking will terminate.

Use the Maximum lIterations text box to limit the number of
iterations used during goal seeking.

Setting user defaults
Information added to the User tab will be transferred to the
File Properties dialog and used on printouts

Enter information as appropriate into the associated text
fields; optionally, select a graphic for use as the company

22 e Speedstack PCB Stackup Builder



logo — optimum graphic size is 180 x 32 pixels — the
graphic is printed in the preview box.

Default User Information

Company Logo

Used to fill in stack property fields when starting a new stack file.

Luthar |.J Travers
C:“Polar'Graphics'polar logo 180x 56 jpa Erowse...
Company |}(YZ Com Q
Recommended size for the logo is 180 pixels in wadth.
Department |Engineering Large images will be scaled down.
Site [North Bridge:
I' ol-h’l‘.l
Specifying default CITS test file parameters
Speedstack allows the user to generate a CITS test file for
each controlled impedance structure within the stack.
Select the CITS Test tab to specify the default test
parameters to be used when initiating a CITS test file.
Horizontal Units Channels
|nits |Inches j Single Ended |Channe| 1 j
Test From 3 Differential |Channe| 182 j
TestTo 7
Test Method |Absalute |
Vertical Scale |-I 0 ﬂ
Differential Unbalanced ‘warning Level [15

Each test file contains the test parameters (test units,
distance, number of channels, etc.) to be used when testing
the stack’s controlled impedance structures using a Polar
CITS (Controlled Impedance Test System).

The test file may be edited via the Edit Test Data dialog.

Choosing background and stackup layer colours
Choose the Colours tab to change stackup component
colours from their factory defaults.
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Iﬂdhesives

Background

Bondply

Coppers

Core Dielectrics
Coverays

Dielectrics

Flexi core

Highlighted Material
|dents ¢ Documentation
Laser Drills NTP
Lager Drlls TP
Mechanical Drills N TP
Mechanical Drlls TP
Peelables

—Base Colour

=}

Resst All

Change |
_Resetal |

Click Reset All to return to cancel changes.

Miscellaneous Options
— Dhelectnic Differential

Maximum Recommended Differential is 1.0
Agcuracy decreases rapidly above this level.

Amalgamated Dielectric Differential Thresheld I1 i

Mumber of Undo Levels |5
Maximum Laser Drilled Layers |5

Use the Miscellaneous tab to specify the maximum Dielectric
Differential when working with multiple dielectric structures;
choose the number of levels of editing Undo and the
maximum number of layers a laser drill can span. (Exceeding
this number will produce a Drill not Valid error message.)

Hatch Defaults

Hatch Fitch |43355
Hatch Wwidth |-|2?_{|.|].

Copper Percentage I:r- mn

o

Use the Hatch Defaults tab to specify the default values for
Hatch Pitch and Width and Copper Percentage when setting
a plane to hatched (see Hatch Configuration.)
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Rebuild and Calculate Structures

These options control the way that the Controlled Impedance structure parameters are
updated from the stack up. When new structures are added or the Rebuild and
Calculate option is selected, Speedstack will update all structures based on the
selections below. Default : All options selected.

[v Substrate Height (H n)

[v Substrate Dielectric (Er n)

v Trace Thickness (T1)

[v¥ Coating Above Substrate (C1)
[v Coating Dielectric (CEr)

The Rebuild and Calculate Structures tab allows the
designer to specify which parameters are included when
controlled impedance structures are recalculated after
modifying the stack.

Manufacturing Constraints

The Manufacturing Constraints options consist of a collection
of manufacturing capabilities, minimum gaps and trace
widths, buried and blind via and trace aspect ratios, drill
aspect ratios, etc. that can be applied during design rule
checking (see DRC tab detail below.)

Iv Manufacturing Tests

v Min. Trace Width [+ Min. Gap \width
Aspect Ratios

I¥ Mechanical Drill I¥ Buried Laser Microvia
Iv Blind Laser Microvia Iv Trace

I Resin Starvation

They will normally refer to differing levels of technology
offered by one or more PCB manufacturers for a range of
prices. The required information (shown in the example
below) can normally be obtained from the manufacturer.

Manufacturing Constraints

Blind Laser ViaA. R.| Buried Laser ViaA | Mechanical Drill A. R. Minimum Gap Minimum Trace Width Trace A R. Units
05 85 75 75 1 Microns
0.5 85 3 3 1 Mils
0.5 85 0.075 0.075 1 Millimetres
0.5 85 0.003 0.003 1 Inches

Current Active Constraint
Highlight Set New Close
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Click the Highlight button to highlight the current active
constraint; to apply a new constraint select the constraint row
and click Set New.

Editing and adding constraints
To modify a constraint or add a new constraint, double click
within the constraint row to be edited.

Edit Constraints
Lnits
" Mils + Microns
" Inches " Millimetres
Option Name |F‘nlar Microns
Minimum Gap |?"5
Minimum Trace WWidth |75
Mechanical Drill AR. 8.5
Blind Via AR. [
Buried Via AR. 05
Trace AR. K
1of 4 = | =
ad | | Cancel
Dane

Modify each setting as required; click Done to confirm the
settings and close the dialog.

To add a new constraint click the Add button, fill in the
settings fields and click Done to finish. The new constraint
will be added to the table of current constraints. Click the
Delete button to remove the constraint from the list.
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Set Target Stackup Thickness/Enable Finishing

Set the Target Stackup Thickness and tolerances via the
dialog below.

Target Stack Up Thickness / Enable Finishing

Target Stack Up Thickness &0.0000 (Mils)

Tolerance

{+ Percent (" Absolute

Positive Tolerance + 10.0 G
Megative Tolerance - 10.0 e

Enable Prepreg Finishing [v
Enable Copper Finishing [

Apply | Cancel |

Tolerance may be set in terms of percentage or absolute
values:

Taolerance

" Percent {* Ahbsolute

Positive Tolerance + 6.0000 (Mils)
Megative Tolerance - 6.0000 (Mils)

Note that positive and negative tolerance values can be set
independently. The values should reflect the currently
selected units.

To enable prepreg and/or copper finishing tick the associated
check boxes. Click Apply.

Note: Unchecking the Enable Finishing options disables the
Apply and Reset Finishing buttons. Note that these buttons
are only available in Materials Library Mode — they are
disabled in Virtual Material Mode.

Finishing Options
From the Tools menu choose the Set Finishing Method
command to display the set finishing corrections dialog.

Speedstack offers two methods: Copper Coverage Method
and Simple Percentage Method.
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Lk
1M

Set Finishing Method >

Copper Coverage Method Simple Percentage Method

Copper Coverage Method Currently
Selected

i

Each method requires that the amount of copper to be added
where plating is required be set. In addition, where the
Excess Resin design rule check is used the minimum
acceptable value must be set.

Simple Percentage Method

The Simple Percentage Method allows the user to set the
percentage of prepreg base height, which will be used to
determine the isolation distance. The percentage is set for
each electrical layer type pair.

3E Percentage Prepreg Corrections *

Frepreg
Set Finished Thicknesses of Prepreg matenials (% of base material)
when prepreg is pressed between:

Signal and Signal layers IWK
Signal and Mixed layers W‘R
Signal and Plane layers W‘R
Mixed and Mixed layers W‘R

Mixed and Plane layers 52.00 %
Flane and Plane layers |55.DI} %

Copper Plated Thickness

Pleaze enter a value of thickness that will be added to base
thickness of copper layers when plating

Copper to be added |D.?DI}E'

Excess Resin Test

Minimum Excess Resin |15 %
Apply | Cancel
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Copper Coverage method
The Copper Coverage method allows the user to set the
amount of copper that will be embedded into the prepreg.

This can be set as a single value for each electrical layer
type. Alternatively the amount of copper embedded will be
calculated on an electrical layer by layer basis dependent
upon the copper coverage for the layer set in the properties
window. The greater the copper coverage the smaller the
amount of copper that is embedded.

ig Copper Coverage Based Prepreg Corrections >
Percentage Copper To Be Embedded in Prepreg

(' Set by Layer type

Signal Layer % |75
Mixed Layer % |15
Plane Layer % |5

" Proportional to Coverage
Copper Finishing

Please enter a value of thickness that will be added to base thickness of
copper layers when plating

Copper to be Added 0.7000

Excess Resin Test

Minimum Excess Resin % |15

Apply | Cancel

Note: The two methods of finishing are not compatible with
each other. The Copper Coverage method requires that the
finished thickness of prepregs be entered in the library; that
value stays locked in the stack unless the Simple Percentage
method is set up; if Reset Finishing is then clicked the
finished thickness reverts to the base thickness.

Virtual Material mode

The Virtual Material Mode command toggles between Virtual
Material and Material Library modes.

Note: Switching to Virtual Material Mode disables the Apply
and Reset Finishing buttons.
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Note: Virtual Material mode and the Simple Percentage
method of finishing are not compatible. Speedstack displays
the message below if the two are selected simultaneously.

Speedstack >

f 0 ) The Simple Percentage Method of finishing is not supported when
"W Speedstack is in Virtual Material Mode. Please use the Tools | Set
Finishing Method and select Copper Coverage Methed.

oK

Working with external utilities

Speedstack can call an external program / utility / script via
the External Utilities menu options. The menu items are
configured via Configuration Options|External Utilities.

1 Choose |  Clear |
2 Choose |  Clear |
3 Choose |  Clear |
4 Choose |  Clear |
5 Choose |  Clear |

To specify a program click Choose and navigate to the
program and click Open. The program will be added to the
External Utility menu.
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The Speedstack toolbar

The Speedstack toolbar comprises shortcut links to the most
popular commands.

Eed YOSl XO == %E 777717

Note: toolbar buttons will be enabled/disabled depending on
whether Speedstack is performing stack editing or controlled
impedance calculations. Pause the mouse over each tool
button to display the tool’s screen tip

File operations

= Create new stackup

LM

E Library mode

' M

E Virtual Material mode

A Stackup Wizard

Stack building operations
| S

Symmetrical Mode off

Symmetrical Mode on

D Mirroring Mode

— Add layer to the stackup

Click to select the layer type. The list of layer types is
displayed in the associated sub-menu.

Layers available include:

Foil Add foil layer to the stackup
Core Add core layer

RCC Add resin coated copper layer
Non-Copper Core Add non-copper core

Prepreg Add prepreg layer

The Speedstack toolbar e 31



Soldermask Add solder mask

Flexible core Add flexible core layer
Bondply Add bond ply adhesive
Adhesive Add Adhesive
Coverlay Add coverlay layer
Ident Add screened ident layer
Peelable Add peelable mask
IL+ Add mechanical/laser drill between layers
Editing the stackup

X
=

Delete selected stackup material or drill

Swap selected material

Note: the Copy and Paste buttons below are only enabled for
the Stack Editor and DRC tabs — they are disabled for the
Controlled Impedance and CI Results tabs.

Copying and pasting materials

J

J

L
S
|

COrY I
! PRSTE
om0

Copy material of the selected layer

Paste material above selected layer

Paste material below selected layer

Copy material properties

Paste material properties

Changing plane types

[=T=T=1

NIRRT

Set the selected electrical layer as a signal layer

Set the selected electrical layer as a plane
Set the selected electrical layer as a mixed
signal/plane layer

Set the selected electrical layer as a hatched
plane
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Note: the Move Selected Layer buttons below are only
enabled for the Stack Editor and DRC tabs — they are
disabled for the Controlled Impedance and CI Results tabs

1 Move selected layer up one layer

T Move selected layer down one layer

—? Display properties dialog for the selected layer
E or drill

Note: the Apply and Reset Finishing buttons below are only
enabled for the Materials Library Mode with the Prepreg and
Copper Finishing Options checked (see Set Target Stack
UpThickness/Finishing Options) — they are disabled for the
Virtual Materials Mode.

Applying finishing

Apply finished thickness

) |05

Reset finished thickness

Changing the stackup view

Display 2-dimensional view

Display 3-dimensional view

I Q)

Proportional Graphics View

Managing the materials library

Go To/Display materials library

Exchanging data with the Si8000m or Si9000e Field solver

Copy controlled impedance data to field solver

Paste controlled impedance data from field solver

oo Bl B

Copy to Si8000m or Si9000e Project
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Creating and editing stackups (Virtual Material mode)

Speedstack provides the option of switching easily between
Material Library and Virtual Material modes allowing the
stack designer to build and experiment with stackups (for
example to examine the effects on impedance structures of
different trace widths or dielectric heights) without requiring
real materials to be entered into a materials library.

In Virtual Material mode the Stackup Wizard allows rapid
entry of stack details, the number of layers, overall board
thickness, plane layers, etc., along with solder mask and
copper thickness. Speedstack will then build a stack to the
specified board thickness by distributing the dielectric
regions equally. If a preferred core thickness is specified the
software will maintain the dielectric thickness for core regions
but then equally distribute prepreg regions to reach the target
board thickness.

This section will describe the steps to construct an 8-layer,
symmetrical FR-4 stack to the specification below using
Speedstack’s Virtual material Mode.

Thickness: 60 mil

Signal layers: 1,3,6,8

Plane layers: 2,4,5,7

Er: 4.2

Preferred core thickness: 8 mil

Copper (all layers): loz. /1.4 mil

LPI Mask: 1 mil

PTH drill passes: Layers 1 -8

Laser microvia passes: Layers1-2,8-7

Impedance structures: SE 50 Ohm Layer 1, Diff 100 Ohm Layer 1

From the Units menu choose Mils/Thou, from the Tools
menu toggle Virtual Material Mode On.

Options Ctrl+5Shift+ 0

Manufacturing Contraints Ctrl+5hift+E
Set Finishing Options

Set Target Stack Up Thickness / Finishing Opticns

Wirtual Material Mode
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Library/Virtual Material mode indicates Virtual Material mode.

Using the Stackup Wizard
From the File menu chose New|Stackup Wizard.

Setting basic stack data
Fill in the dialog as shown below.

Stack Up Wizard (Virtual Material Mode)

Number of Layers I_jv Mominal Dielectric Constant 42
Target Stack Up Thickness IGDl}[I'[I'D
Positive Tolerance % Im Solder Mask Top v
Megative Tolerance % I'H] Solder Mask Bottom v
Symmetrical v Solder Mask Dielectric Constant |3
Flane Layers Mixed Layers Sclder Mask Thickness I'I .ooo
] ; Preferred Core Thickness Select ;I IE,D-I}DD
3 i Copper Thickness |1-4U'D'D
5 )
3 6 —Build Type
2
8 8 ' Fail " Core " Sequential/HOI
Pre Next = Finish Cancel
Click Next to add drills.
Adding drills
Select Column 1 and specify the First Electrical Layer as
Layer 1 and the Second Electrical Layer as Layer 8; choose
Mechanical, Through Plated with No Fill and click Add to add
the first drill to the stack.
Add Drills
—Electrical Layers -
Column First Electrical Layer No Second Electrical Layer No
I = = s =
— Drill Information —Hole Information
&+ Mechanical Fill Type Hele Count
" Laser No Fill LI I{II
" Laser (Stacked) Different Hole Sizes
Iﬂ
v Through Plated
) Minimum Hole Size
Data Filenames
oo

Delete Last |  Delete Al

<Previous |

Finished |  Cancel |

Creating and editing stackups (Virtual Material mode) e 35




Adding microvias

Choose Column 2, specify the First Electrical Layer as 1 and
the Second Electrical layer as 2; choose Laser with No Fill
and click Add. Repeat the process to add another microvia to
Column 2 between electrical layers 8 and 7 (shown below.)

Click Finished.

The Stackup Wizard displays the New Stackup File
Properties dialog; enter the (optional) stackup properties.

New Stackup File Properties = B
The fields below are optional
Descriptive Stackup Name IM—Board W Stack
Stack Top Side Label |
Stack Bottom Side Label |
Date Created |0710/2m3
Wersion IHev 000
Revision Show/Hide Revision Information
Author M
Company IPolar
Department |Engineering
Site |North Ind Estate
Associated Documents

ok | Skip |

Click OK to close the dialog and edit the stack. Speedstack
builds the stack to achieve the specified board thickness.

Click the 2D button to assist in visualisation while editing the
stack.
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Core

PP

Use the View menu to zoom in and out of the stack.

Zoom In
Zoom Out
Zoom Extents
Default View

Hint: Click the mouse wheel in the Stack Editor (Zoom
Extents) to view the entire stack.

The Stackup Editor displays summary information for the
whole stack and for items within the stack as they are
selected.

—Stack Up Information
Field | Value
Electrical Layer Count 8
Stack Up Cost 0.00
Copper Thickness 11.0236
Dielectric Thickness 51.9635
Solder Mask Thickness 1.9635
Target Stack Up Thickness 629521
Stack Up Thickness 629521
Stack Up Thickness with Scldermask 6459608
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Selected Item Information : Drill

Field Walue
First Electrical Layer Mo g
Second Electrical Layer Mo 7
Mechanical Drill False
Laser Dnll True
Fill Type Ma Fill
Data Filenames

Hole Count 0
Different Hole Sizes 0
Minimum Hele Size 0.001
Minimum Allowable Hole Size 15.2000

Editing the stack

With the “virtual” stack in the Stack Editor the stack can be
changed as required.

Changing material properties

To change the properties of a material, right click the
material in the stack and choose Properties; fill in the text
fields with the associated information and click Apply. Most
material properties can be changed, including the material
descriptions, base and finished thickness, dielectric
constants, drill parameters along with the graphical colours.

Choosing Symmetrical mode
: Stackups are often designed symmetrically to prevent
piy warping and twisting — using similar materials in the top and
— | Symmetrical OFF  pottom halves of the stack. Clicking the Symmetrical button
Ea will toggle the Symmetrical mode on or off. In Symmetrical
' mode the stack editing functions will process materials in
the upper and lower halves of the stack simultaneously.

““ | Symmetrical ON

Changing the material description

In this example stack, ensure symmetrical mode is selected
then right click the solder mask material in the stack to
display the Solder Mask Properties dialog.
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Solder Mask Properties

Main ]No‘teg ]
‘General Information Apply
Supplier | Cancel

Pl

Supplier Description | Close

Diescription |Liquid Photo Imageable (LPI)
Stock Number |

Type |

Solder Mask

Thickness 1.0000 Dielectric Constant 3.0000
Mask Colour Graphical Colour _

Data Filename

Change the Solder Mask Description to Liquid Photo
Imageable (LPI).

Description ||Jquid Photo Imageable (LPI)

The change on the Description in both solder masks is
reflected in the Editor window.

Liguid Photo Imageable (LPI)

Liquid Photo Imageable (LPI)

Changing electrical layers

Electrical layer types may be changed from plane to signal,
mixed and hatched. Right click the layer to be changed and
choose from Signal, Plane, Mixed or Hatched.

Set to Signal
Set to Plane
Set to Mixed
Set to Hatched

Speedstack will take the designated layer type into
consideration when adding controlled impedance structures.

Creating and editing stackups (Virtual Material mode) e 39



Setting hatched planes

With the XFE option Speedstack supports hatched planes,
implementing the same crosshatch calculation technique
used in the SiB000m / Si9000e. If a crosshatch plane is
Set Layer to Hatched  required click Set Layer to Hatched Plane —use the Hatch
Plane Configuration dialog to set hatch pitch and width or set the
hatch width by percentage copper area. Click Apply.

M

Hatch Configuration Gk wp [170701 )
'\.H P HW Hatch Width Hw [ — J—

‘\ —Set Hatch Width for desired Copper Area %

| 5.:‘ I I I
.00

Non Copper Area %

Adding controlled impedance structures

To add controlled impedance structures, click the Controlled
Impedance tab, select the copper layer (in this example,
Layer 1) and click the Add New Structure button.

Stack Up Editor | DRC - 3 [ Controlled Impedance || ¢ Resuits |

+

|Add Mew 5tructure|

Speedstack suggests structures valid for the layer based on
the plane layer types.

Structure Control

—Mumber Of Signal —
Tracks Apply |

¥ Single Trace

" Differential Co ed1r~E1licm ip
E Advanced |

Coated Coplanar
Strips With Low...

Apply Al |

For this example, choose a 50 Ohm single ended coated
microstrip; leave the tolerance at 10%; click Apply then Done.
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. The new structure is shown in the stack, highlighting the
Structure on Layer materials employed by the structure.

The structure also appears in the Controlled Impedance
panel, along with its parameters.

X XOEOE >« o
L ] < || |

Substrate 1 Height H1[62000
Substrate 1 Dielectric Er1[42000
Lower Trace Width W1 [5.9055

Upper Trace \idth w2 49213
Trace Thickness T1 |1.4000

Coating Abowve Substrate ci1fiooo0
Coating Above Trace cz[tooo0
Coating Dielectric Cer[30000
Impedance Zo[ooo
Target Impedance [50.00
Target Tolerance % Mooo

Calculating the structure impedance

Parameters calculated from the stack materials, such as the
substrate height and dielectric are read only and shown
greyed out; other parameters may be edited. If the editable
parameters are known they may be entered directly. For
example, modify W1 to read 10.5 and W2 to read 9.5 and
click the Rebuild and Calculate All Structures

The impedance is calculated as 50.52 Ohms
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Goal Seeking the target impedance

Speedstack can adjust one or more structure parameters to

E Goal Seek button achieve a specified target impedance. Leave the Target
Impedance at 50 Ohms and click the Goal Seek button

From the Set Up Goal Seek dialog choose W1/W2 only

Set Up Goalseek

[

Goal Seeking Parameter(s)

{+ W12 only
~

H1 Only

i I B e B B

oK | Cancel |

Click OK — Speedstack adjusts trace width (below) to
achieve the target 50 Ohm impedance.

Substrate 1 Height H1 |&.2000
Substrate 1 Dielectric Eri[42000
Lower Trace \Width W1 10.7037
IUpper Trace ‘width W2 |9.7037
Trace Thickness T1 [1.4000
Coating Above Substrate C1 W
Coating Above Trace C2 [1.0000
Coating Dielectric CEr|3.0000
Impedance Zo W
Target Impedance IW
Target Tolerance 3% W

With the impedance in tolerance the navigation buttons
display green.

Mirroring structures

This example stack is symmetrical so structures may be
copied to the lower half of the stack (i.e. on the lower outer
layer.) Click Mirror Structures if Stack Symmetrical.

The impedance structure on Layer 1 is copied to Layer 8.
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Rebuilding the stack

During stack editing changes to the stack (for example,
inserting prepreg materials into a layer or altering the existing
material thickness) will affect the impedance value of one or
more structures. If Speedstack senses that an impedance
structure has changed it issues a Rebuild alert.

All |Rebuild And Calculate All Structures|

Click Rebuild and Calculate All Structures — Speedstack
recalculates the impedance for the new parameters. If the
impedance value is out of tolerance the structure browse
control changes colour to red.

Virtual Material mode allows the designer to experiment with
material properties to examine the effects on impedance
structures of different trace widths or dielectric heights, etc.
Materials may be added, moved, copied, pasted or removed
and the properties of materials changed — Speedstack will
sense the changes and allow the “generic” stack to be rebuilt
and recalculated.
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Creating and editing stackups (Material Library mode)

This section describes creating stackups using the Material
Library mode. Stackups may be created manually using the
Stackup Wizard or using the editing window. Ensure Tools|
Virtual Material Mode is toggled Off.

Using the Stackup Wizard
The Stackup Wizard guides the user through the process

.B of creating complex stackups in only a few steps. Click the
Stackup Wizard button or choose Stackup Wizard from the
Stackup Wizard button File|New sub menu. The ;tackup editing window is cleared
and the Stackup Wizard displayed.

AL stack Up Wizard (Material Library Mode) — O x

General Planes and Mixed Layers

Layer count A ¥ Symmetrical

Build Type | j Plane Layers Mixed Layers

Materials

Soldermask | J

Fail | [

Prepreg | J Clear Clear

Prepreg | J 4 —

Prepreg | J Drilling

Core | J [ Through-Plated [ Mon Through-Flated

Apply | Cancel |

Stack Up Thickness: 0 (Mils) Stack Up Thickness with Soldermask: 0 (Mils)

Using the Wizard the user can specify the layer count and
build type, stackup materials, planes and drill types in a
single operation.

Electrical layer count

Begin by specifying the electrical layer count — up to 64
electrical layers may be specified. Choose the number of
layers from the drop down list box.

Build type

Choose the build type (Foil or Core) from the drop down list
box. Core builds contain only core materials; most builds will
be foil builds — containing internal layers of cores with two
outer foils.
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General

Layer count R -
Build Type | Foil ] @

Choosing stackup materials
Note; if Core build type has been specified the Foil material
control will be disabled.

The Wizard allows for a stack comprising solder mask, foil,
and cores with up to three prepreg materials between.

AL stack Up Wizard (Material Library Mode) — O >
General Planes and Mixed Layers
Layer count 8 - ¥ Symmetrical
Plane Layers Mixed Layers
Build Type |Foil | ] ]
2
3 3
Materials 4
5
Soldermask |Liquid Photolmageable Masle SM: Clear g 6
Fail |Copper Foil FO/002 Clear a é

]
]
Prepreg |PrePreg 1080 PP/DDN J Clear Clear Clear
Prepreg |PrePreg 1080 PP/DO1 J Clear
|
]

Drilli
Prepreg | Clear R

Core |FR4Core co/017 Clear [+ Through-Plated [ Mon Through-Flated

Apply | Cancel |

Stack Up Thickness: 59.2 (Mils) Stack Up Thickness with Soldermask: 61.2 (Mils)

The Wizard displays a running total of the stackup thickness
in the Wizard’s status bar.

Adding layers

El To include a layer (in this example a foil layer) click the Foil
Add Material button; the library of foil materials is
displayed. Choose the foil material from the list and click
the Add Material Above button; the material is added as a
foil layer to the stackup.

IiT]
L]

SN | = Y Y

Supplier Supplier Description| Description Stock Mumber | Cu Base Thickness | Type
» PolarSamples FO/004 CopperFoil 0.7 100004 0.7 Copper
PolarSamples FO/002 CopperFoil 1.4 100002 1.4 Copper
PolarSamples FO/003 CopperFoil2.8 100003 2.8 Copper
PolarSamples FO/005 CopperFoil0.7 100-005 0.7 Copper
PolarSamples FO/006 CopperFoil 1.4 100005 1.4 Copper
PolarSamples FO/005 CopperFoil2.8 100-005 2.8 Copper
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Repeat the procedure for prepreg and core materials and the
(optional) solder mask layers. Use the Clear button to
remove a layer from the stackup.

Materizls

Soldermask |Uquid Photolmageable Mask SM: . | Clear |
Foil [Copper Foil FO/002 .| Clear |
Prepreg [PreFreq 1080 PP/00T | Clear |
Prepreg [PreFreq 1080 PP/00T | Clear |
Prepreg | | Clear |
Core [FR4 Core CO/017 | Clear |

Nominating power planes and mixed layers

Use the list boxes to specify planes as power planes or
layers as mixed layers. Select all planes as required. To
remove a plane from the list select the plane number from
the list and click Clear.

Flanes and Mixed Layers
v Symmetrical
Flane Layers Mixed Layers
1 1
2
3 3
4
h
& &
] H
Clear Clear

The dialog above shows Layers 2, 4, 5 and 7 specified as
power planes

Adding drill information
To add a drill between electrical layer 1 and the last layer

click the Through-Plated and Non-Through-Plated check
boxes as required.

Drrilling

W Through-Plated [~ Non Through-Plated @

With all build options specified click Apply to complete the
stackup. The finished stackup appears in the Editor window.
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Core

PP

PP

Liquid Photolmageable Mask

Copper Faoil
PrePreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080
PrePreg 1080

Copper Foil

The example stack below includes two prepreg materials
between layers.

1.000

3.000

Yy O 99 094 3.000

8.000

3.000

3.000
8.000

3.000

3.000
8.000
3.000

3.000

1.000

Liguid Photolmageable Mask

Summary information is shown in the Status Bar and
includes the units in use, the target stackup thickness and
the stackup thickness without and with soldermask.

[Mils/Thous

|Target Stack Up Thickness = 60.0000 |Stack Up Thickness = 59.2000 |Stack Up Thickness with Soldermask = 61.2000
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Changing the stackup view

2 For many editing operations changes to the stack may be
d _ easier to visualize when shown two-dimensionally. Click the
See 2D View See 2D View button

Liquid Photolmageable Mask 1.000
Copper Foil
PrePreg 1080 3.000

PrePreg 1080 3.000

FR4 Core 8.000

PrePreg 1080 3.000

PrePreg 1080 3.000

FR4 Core 8.000

PrePreg 1080 3.000

PrePreg 1080 3.000

FR4 Core 8.000

PrePreg 1080 3.000

PrePreg 1080 3.000

Copper Foil

Liquid Photolmageable Mask 1.000

Filtering Materials

When adding or swapping materials, available materials
(foils, prepregs, etc.) are listed in the associated material
library dialog.

Lists can be filtered for materials matching desired
parameters (dielectric thickness, Er, etc.) See Using
Speedstack Materials Libraries.

Saving stackups
It is strongly recommended that users save work frequently and
maintain safe backups of stackups and projects.
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Creating stackups manually

Go To Materials Library

Speedstack allows the designer to add or edit stackup layers
in any order, from top to bottom, bottom to top or from the
centre layer outwards. This example will create a four-layer
stackup, starting at the centre core layer and adding layers
above and below.

Editing the stack

When editing the stack it will probably be most convenient to
right click an object in the stack and select the associated
command from the context menu. The menu will reflect the
commands available for the selected object — commands
that are not appropriate for the object are greyed out.

Add » Fail
Core

RCC

Add C.I. Structure

Full Stack Up Editor Mode
Flexible Core

5 5i
Set to Signal Bondply

g
Setto Plane Adhesive

Set to Mixed

Set to Hatched

Prepreg
MNon-Copper Core
View Hatch Profile Soldermask
Edit Hatch Profile Coverlay

Copy Ident

Paste Above Peclable

Paste Below Dirill

Delete
Swap
Mowve Up

Mowe Down
Properties

Flexi-Rigid 3

Alternatively, select the object (copper, prepreg, core, etc.)
with the left mouse button and choose the command from
the Speedstack toolbar.

Adding layers to the stackup

Items added to the stackup are added from the currently
open materials library. Speedstack opens Program
Files\Polar\Speedstack\default.mlbx if it exists; if a different
library is required, open it via Go To Materials Library.

Note: Speedstack does not ship with the default.mlbx library.

For this discussion open one of the two sample library files,
Speedstack Imperial.mlbx or Speedstack Metric.mlbx (stored
in the Program Files\Polar\Speedstack\Samples folder at
installation time for a default installation.)
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Caution: Consistency of units

When defining dimensions for a stackup (for example, layer
thicknesses) ensure that all measurements are defined using
the same units (mils, mm, etc.) throughout the structure and
its libraries.

Note: the libraries supplied for these examples are preloaded
with sample data only.

Click the File|]New command to clear the stackup screen and
notes and information text areas.

Click the File|Save Stackup or Save Project command to save
the stackup or project. Users are recommended to save
stackups or projects frequently during the stackup creation
process to avoid data loss. Stackup files, project files and
library files should be backed up to a secure location.

Adding a core layer

Eﬂ- Click the Add Layer Material button and choose Core...the
——= Core library is displayed

The Core library contains full details of the core material,
including base and finished thicknesses, dielectric constant,
and upper and lower copper thicknesses.

Supplier Description | Description | Stock Number Dielectric Base Thickness | Dielectric Finished Thickness | Dielectric Constant UpperCu Base Thickness | Lower Cu Base Thickns

COM001 FR4 Core 2 400-001 2 2 42 0.7 0.7

Covo02 FR4 Core 2 400-002 2 R 4.2 1.4 1.4

Covo03 FR4 Core 2 400-003 2 2 4.2 28 28

CovoD4 FR4 Core 3 400-004 3 3 4.2 07 07

Covo0s FR4 Core 3 400-005 3 3 4.2 1.4 1.4
Click on any of the column buttons to sort the library list by
the selected column.

— Choose a core type from the list of cores and click the Add
Add Material above Material Above button. The core is added to the stackup

screen. When editing a stack this button adds a core above
the selected layer.

Stackup core layer

oo, Layers may also be added below the selected layer. The Add
% | Add Material below  Material below button adds a core below the selected layer.

As each layer is added the stackup information table is
updated to reflect the current status of the stackup.
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Stack Up Information

Field Value
Electrical Layer Count g

Stack Up Cost 0.00
Copper Thickness 11.0236
Dielectric Thickness 51.9685
Solder Mask Thickness 1.9685
Target Stack Up Thickness 629521
Stack Up Thickness B2 9521
Stack Up Thickness with Soldermask  64.9606

Stackup information table

Note: The Stackup Information is printed in red when the
stack thickness is outside its tolerance.

With the core selected, the Selected Item table displays the
properties of the core.

Selected Item Information ; Core

Field Value B
Supplier Description CO/M6

Description FR4 Care

Stock Mumber 400-016

Type FR4

|lpper Cu Base Thickness 0.7000

Upper Cu Finished Thickness 0.7000

|Ipper Copper Coverage 0 o
Minimum Trace Width 259628

Data Filenames

Dhielectric Base Thickness 2.0000

Dhelectric Finished Thickness 2.0000

Dielectric Constant 42

Resin Content 45

Tg 180

T4 n ﬂ

Core layer information

To observe the properties of any material, click the material
in the stack and read off the properties in the Selected Item
Information panel.

Editing the selected layer properties

To change the properties of the selected object (for example,
to modify the dielectric constant or the value for the finished
thickness of the dielectric), right click the object in the
stackup and choose Properties from the shortcut menu; in
this example the Core Properties dialog is displayed.
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Note that the Enable Finishing setting in the Tools|Set
Stackup Thickness/Finishing Options dialog must be
unchecked to enable the Finishing Thickness to be specified
manually.

Change the value to the corrected value and click Apply.

Core Properties
Main l Notes ]

General Information Apely
Supplier ‘Polar Samples Exchange Copper r Close
Supplier Description [coso1e
Description ‘FRL Core Cast W
Stock Number [400-018 Tolerance [loon
Type [FRa Lead Time poo
Upper Copper

Base Thickness [2eoo0 Finished Thickness 2.8000

Copper Coverage % oo Graphical Colour l—

Data Filename |

r Remove Copper r

Finishing Applied r
Dielectric

Base Thickness ’W CAF Resistance ’—

Finished Thickness [Boooo 7 Axis Expansion po

Dielectric Constant W Excess Resin W

Resin Content % W Isolation Distance ,W

Tg W Graphical Colour ,7

Td b0
Lower Copper

Base Thickness [2eo0 Finished Thickness 2.8000

Copper Coverage % 0.00 Graphical Colour

Data Filename

I Remove Copper r
Finishing Applied r
Y.

Set Layer to Plane

Adding data file names
If available, add the data file name(s) to the upper and lower
copper layers and click Apply.

Close the dialog when all changes are completed.
Changes will be reflected in the Stackup Information table.

Changing a layer function
In this example both the signal layers above and below the
core dielectric are changed to planes.

Click the lower signal layer and click the Set Layer Plane
button. Repeat for the upper signal layer.

The changes are reflected in the stackup window
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Exchanging layers

To change just the core dielectric (leaving the copper layers
unaffected), right click the core material (for example the FR4
in the graphic above) and choose Swap from the context

Q menu or left click the core material and click the Swap
Selected Material button. Choose the new core type from the
Swap Selected Material library and click the Swap button. The layer properties will

change to reflect the new material and changes appear in the
Stackup Information table.

Adding prepreg layers
" With the core selected, click the Add Material button and

— choose Prepreg...; the Add Prepreqg library is displayed.
&= | Add Material

Supplier Description | Description Stock Mumber | Dielectric Base Thickness | Dielectric Finished Thickne| Dielectric Constant | Resin Content | Tg
PPO01 PraPrag 1080 300-001 3 3 4.2 a0 180
PPO0O2 PrePreg 3080 300-002 3 3 4.2 a0 180
PP/OO3 PrePreg 3113 300-003 4 4.2 53 180
PPiO04 PrePreg 1651 300-004 (7 6 4.2 47 180
PP/OO5 PrePreg 7628 300-005 7.8 7.8 4.2 45 180
PP/OD6 PrePreg 106  300-005 2 2 4.2 a0 180

The Prepreg library contains details of the prepreg material,
including the prepreg’s base and finished thickness and
dielectric constant.

Choose the Prepreg material from the database and click the

+
T Add Material Above button.
Add Material Above

PrePreg 10580 e annasaasaa 3 000

FR4 Core 5.000

The prepreg layer is added above the core.

To change the properties of the prepreg material right-click
the layer and choose Properties from the short cut menu. For
example, the value for Finished Thickness can be modified
to reflect the effects of the pressing process.

Dielectric
Base Thickness [fooo0 Finished Thickness [fooo0
Dielectric Constant ’7 Resin Content % ’7
Ta [120.0000

Select the Core material and click Add Material|Prepreg to
"'"|="'!|_"" display the prepreg library and click the Add Below button. The
layer of prepreg is added below the core.

Add Prepreg Below
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PP

Core

PP

PrePreg 1080

FR4 Core

PrePreg 1080

Modify the properties as necessary.

Choosing the Display Data fields

The Speedstack Stack Editor provides a range of useful data
fields for optional display alongside each material. Base and

Finish (Display Field 4) refer to thicknesses and weights and

appear to the left of the stackup graphic.

Hatch Defautts | Extemal Utilties | Rebuild and Calculate Stuctures |

General IStmcture Defaults I Licensing I File Locations I Goal Seeking I Auto Stack I User I CITS Test I Colours I Pazswords

—Default Stack Up View ——— [ Display Data
o Display Fields 1 and 2 are reserved for Layer Numbers and Layer Types
Display Field 3 Display Field 4 | Display Field 5
@ Description +| |Base Thickness LI Finished Thickness =
Finished Thickness ~
. Finished Thickness Copper Coverage
[ Units Copper Coverage Isolation Distance
lsolation Distance Dielectric Constant
@ Mils/Thous " Microns  Millimetres {| Dielectric Constart Resin Content
Resin Content Tg
Ta Colour
Processed Thickness ¥ Data Filenames hd

¥ Open last used file on application start up

¥ Display File Properties Dizlog for Mew Stackups and Projects

Apply

Display Field 5 appears to the right of the stackup graphic.
Choose the data of interest from the drop down lists.

Note: Processed Thickness is the Finished Thickness for
copper layers and Isolation Thickness for dielectric layers.

Adding a foil layer

Select the upper layer of prepreg and click the Add Layer
Material button and choose Foil to display the copper foil
library.

Supplier Description | Description | Stock Number | Cu Base Thickness | Type | Cost | Lead Time
FCWoD1 Copper Foil  100-001 0.7 Copper 1 a
Fowon2 Copper Foil 1004002 1.4 Copper 2 a
FCWoD3 Copper Foil  100-003 2.8 Copper 3 a

Choose the foil type and click Add Above, the copper foil
layer is added above the selected prepreg layer.
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PrePreg 1080

FR4 Core

PrePreg 1080

Repeat the procedure for the lower prepreg layer: select the
lower prepreg layer and add a layer of copper foil below the
layer (shown below as layer 4 in the 3D view).

Copper Foil / ‘ ‘ ﬁ ‘ ‘ : ’

PrePreg 1080
FR4 Core

PrePreg 1080

Copper Foil

To alter the foil properties, right-click the foil layer and
choose Properties. Using the Properties dialog the user can,
for example, specify that the trace is shown inverted.

—Copper

Base Thickness [1-2000 Finished Thickness [ta000

Copper Coverage % I{I'.ﬂ'[I' Graphical Colour _
M r
-

Diata Filename I

Trace Inverted

Finishing Applied

Note that the stackup is being built symmetrically about the
centre layer.

Adding solder mask layers

With the upper layer of foil selected, click the Add Layer
Material button and choose Soldermask to add a layer of LPI
solder mask above the foil.

Supplier Description | Description | Stock Mumber | Mask Thickness | Dielectric Constant | Colour | Type Cost
SMAa01 Liquid Photolmegesbe Mesk 500-001 1 4 Green Solderssk 0.5
Snin2 Liquid Photolmagesabke Mesk 500-002 1 4 Green SolderMask 0.6
Shao3 Liquid Photolmeageabke Mask 500-003 1 4 Blue SolderMask 0.6
ShO04 Liquid Photolmagesbe Mesk 500-004 1 4 Red SolderMask 1
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Repeat the process for the solder mask material below the
lower foil layer.

Liguid Photolmageable Mask

Copper Foil ; s ‘ ‘ ﬁ ‘ : : ’

PrePreg 1080

FR4 Core

PrePreg 1080
Copper Foil
Liquid Photolmageable Mask

Adding the Ident layers

Select the lower LPI Soldermask layer and click the Add
Layer Material button and choose Ident to add a layer of
Screened Ident below the layer. The sample Ident library
includes ink thickness and colour

Supplier Description | Description | Stock Mumiber | Ink Thickness | Colour | Type | Cost
ICvo01 Screensd ldent  §00-001 2 White Ident 0.1
IvoD2 Screenad dent 600-002 2 Yelow Ident 0.1
1DvD03 Screened |dent  §00-003 2 Black Ident 0.1

Repeat for the upper layer.

Screened |dant
Liquid Photolmageable Mask

Copper Foil : Ve “ ‘ ‘ ‘ ‘ ’

PrePreg 1080
FR4 Core

PrePreg 1080

Copper Foil

Liqgud Photolmageable Mask

Screened |dent
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L
AddDrill

Adding a drill
To add a drill between layers click the Add Drill button; the
Add Drill dialog is displayed.

ig Add Drill *
Elecincal Layers
Column First Electrical Layer No Second Electnical Layer No
i T ST =l
Drrill Information Hole Information
{* Mechanical Fill Type Hole Count
Yiaser Na Fil EIRE
(" Laser (Stacked) Different Hole Sizes
¥ Through Plated o
Data Filenames Minimum Hole Size
|0.002
pdd | Clese |

Select the column in which to place the drill.

Choose the first and second electrical layer numbers (layers
1 and 4 in the example).

Specify the drill type, mechanical or laser and whether
through plated. Note that with laser drills the order of drill
layers is important, e.g. layer 1 and 4 is different from layer 4
and 1. Optionally, add the NC drill data filenames.

Optionally, add the hole count, number of different hole sizes
and the minimum hole size. Click Add and close the dialog.
The drill information is added to the stackup. The example
below contains through plated and laser drill information.

Deleting drills

To delete a drill right click the drill and from the context menu
choose Delete. To delete all drills choose Delete all Drills —
confirm via the dialog below.

Speedstack >

You are about to delete ALL drills from the stack. Do you wish to continue?

es Mo Cancel

All drills will be cleared from the stack.
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The finished stackup is shown below

D Screened dent

SM Liquid Photolmageable Mask

Fail Copper Fail

PP PrePreg 1080

Core FR4 Core

PP PrePreg 1080
Fail Copper Foil
SM Liguid Photolmageable Mask

D Screened |dent

Adding stack vias

Speedstack can add stack vias to the stackup in a single
operation. To add stack vias between layers 1 and 5 in the
stackup below, select layer 1 and click Add Drill.

1.000

Liquid Photolmageable Mask ’

Copper Foil M
PrePreg 3113 .
Copper Foil

PrePreg 1651

Copper Foil

PrePreg 1651

Copper Faoil 5.000

LM LSS

PP PrePreg 1651

Care FR4 Core

Specify the column number and electrical layers 1 and 5 and
choose Laser (Stacked) — from the Fill Type drop down list
choose Copper. Click Add.
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5E Add Drill >

— Electrical Layers
Column First Electrical Layer No Second Electrical Layer No
I T cl: = &
— Drill Information —Hole Information
" Mechanical Fill Type Hele Count
" Laser Copper B
@ Laser (Stacked) Different Hole Sizes
¥ Through Plated o
Data Filenames Minimum Hole Size
0.0020
Add | Close

The stack vias are added to the stack (below.)

Note: The drill properties (i.e. Drill Information and Hole
Information) are retained between each Add Drill operation.
This can speed up the process of adding drills, especially
when multiple drills of the same type are being added to the
stackup.

1.000

Liquid Photolmageable Mask

Copper Foil

PrePreg 3113 "o
Copper Foil

PrePreg 1651

Copper Foil

PrePreg 1651 "o
Copper Foil 8.000

PP PrePreg 1651

5627

Core FR4 Core

Deleting a layer
To remove a layer from the stackup select the layer and
x click the Delete button.

Delete Selected Material

Copying a layer

With layers defined it will often be found more convenient to
—_— copy an existing layer and paste it into the stackup than to
! create a new layer “from scratch”. Select the layer to be
copied and click the Copy Selected Material button. Click the

Copy Selected Material
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omO
COPY

Copy Material
Properties

layer nearest the destination location and choose Paste
Above or Paste Below as appropriate

Note: when modifying the stackup it may be necessary to
redefine the drill information to reflect the changes.

Copying material properties

Speedstack can copy material properties from one material
in the stackup and paste them onto multiple materials
simultaneously.

For example, to replace the three prepreg materials below
Layer 3 in the stackup below with the Layer 1 material,
PrePreg 1080, select the source material (shown highlighted
below) and click Copy Material Properties

1.100

1850

Liguid Photolmageable Mask

Cop ilc

PrePre

FR4 Core
PrePreg 3080
PrePreg 1651

PrePreg 1651

& & 4 50

3100

> L7 PP

12.000

Select the three target layers

1.100

1.950

Liquid Photolmageable Mask

Copper Foil C

PP PrePreq 1080

Core FR4 Caore

PP
PP

PP

Paste Material
Properties

3100

12.000

Click Paste Material Properties — the Paste Material
Properties dialog is displayed.
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Paste Material Properties

Flease select the Property Groups that you wish to paste to the selected materials:

General Properties (All Matenials)
[v General Information (Supplier, Description, Stock Number etc)

[ MNotes (5 x Mote properties)
[v Colour (Draw colour)
Conductor Properiies (Foil, Core, RCC, Flex Core)
v Copper (Base and Finished Thickness, Copper Coverage etc See Mote 1)
MNaote 1: Layer Numbers and Layer Types assigned to Copper layers are not copied.

Dielectric Properties (Core, RCC, Prepreg, Flex Core, Bondply, Adhesive)
[+ Diglectric (Base and Finished Thickness, |solation Distance, Dielectric Constant etc)

Solder Mask Properties (Solder Mask)
[ Solder Mask (Thickness, Dielectric Constant efc)

Coverlay Properties (Coverlay)
[v Caoverlay (Base and Finished Thickness, Dielectric Constant etc)

Ident Properties (ldent)
[ ldent (Thickness etc)

Peelable Properties (Peelable)
[¥ Peelable (Thickness tc)

¥ Select/ Deselect All Aoply | Cancel \

Select the property groups that are to be applied to the target
materials and click Apply. Properties that do not apply for a
material type are ignored.

Liquid Photolmageable Mask
Copper Foil C
PrePreg 1080

FR4 Core

PrePreg 1

PrePreg 108(

PrePreg 108(

In this example all material properties have been applied to
the three target materials.

Note: When changing multiple materials simultaneously it is
important to review the resulting stackup. It will probably be
necessary to recalculate any associated controlled impedance
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i

Move Selected Material Up

1

Move Selected Material Down

]

Apply Finishing

KL

Reset Finishing

=

See 2D View

Screened [dent

structures, especially if dielectric height and copper thickness
parameters have changed.

Moving materials
To move materials within the stackup use the Move

Selected Material Up and Move Selected Material Down
buttons.

When a material is moved it is exchanged with the layer
above or below, respectively.

Applying finishing
To apply the finished thickness factor throughout the board,
click the Apply Finishing button with no material selected.

To reset the finished thickness back to the original base
thickness of the materials throughout the board, click the
Reset Finishing button with no material selected.

Note: when applying or resetting finishing, if a material is
selected it will be necessary to specify whether finishing is to
be applied to the selected material only or the whole stack.

Displaying the stackup in 2-dimensional view

To change the view of the stackup from its default 3-
dimensional aspect, click the See 2D View button. The
stackup is displayed in 2-dimensional view.

Liqud Photolmageable Mask

Copper Foil

PrePreg 1080

FR4 Core

PrePreg 1080

Copper Foil
Liquid Photolmageable Mask

Screenad [dent

See 3D View

Click the View 3D button to restore the 3 dimensional view.

Mirror Build

Mirror Build allows the designer to consider the stack in two
halves, designing and building, for example, just the top half
and mirroring the structure into the lower half.
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Symmetrical Builds

L

View 2D button

Build the top half of the stack, including any controlled
impedance structures and click the Mirror Build button;
specify whether the current set of layers is the upper or lower
half of the stack. To maintain symmetry, Speedstack will add
a layer of material as appropriate to the stack;

Mirror Build

Which half of the new stack is this?

i E)

It will be necessary to add ancther prepreg to Cancel
complete the Mirrored stack.

the stack is reflected symmetrically into the lower half.

In Symmetrical Build mode the Speedstack maintains stack
symmetry as the stack designer creates or edits a stack.
Changes in one half of the stack are reflected in the opposite
half of the stack to ensure a symmetrical stack.

This example considers an 8-layer stack — beginning with
three cores and then using Symmetrical Build.

Creating a new stack
Create a new empty stackup and add three cores.

S F SIS

y 7 P P77
y 77 77774

When constructing complex structures it will often be found
easier to use the two dimensional aspect.

To change the view of the stackup from its default 3-
dimensional aspect, click the See 2D View button. The
stackup is displayed in 2-dimensional aspect.
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1';';,_..-

Symmetrical OFF

_ﬁu:ll.:fﬁ

£

Symmetrical ON

Core  FR4 Core

Core  FR4 Core

Core  FR4 Core

FR4 Core

FR4 Core

PrePreg 1080

FR4 Core

Adding a prepreg layer in Symmetrical Mode
In this example it is necessary to add prepreg layers
between cores to achieve the required dimensions.

Switch to Symmetrical Mode and work in the top half of the
stack — in Symmetrical Mode as layers are added to the top
half of the stackup the Speedstack will add layers to the
lower half of the stackup to maintain stack symmetry.

To add a layer of prepreg between Layers 2 and 3 select
Layer 3 (the selected layer is shown highlighted in the figure
below.)

Click the Add Material button and add a layer of prepreg
above Layer 3 (shown highlighted in the figure below).

In Speedstack’s symmetrical mode the prepreg layer is
automatically reflected in the lower half of the structure.
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Adding a second prepreg layer

Now add a second layer of PrePreg 1080 above the layer
just added; the new prepreg layer is reflected in the lower
half of the stack as shown below.

FR4 Core

PrePrag 1080

FR4 Core

PrePreg 1080

PrePreg 1080

FR4 Core

Next, add a layer of prepreg above layer L1 in the upper half
of the stackup.

Speedstack in symmetrical mode automatically maintains
stack balance by adding the corresponding layer below L6.

FR4 Core

PrePreg 1080

PrePrag 1080
FR4 Core

PrePreg 1080

PrePreg 1080

FR4 Core

PrePrag 1080
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Adding foil, LPI Mask and Ident layers
Next, add a foil layer (L1 below) which is mirrored as L8; as
part of the process Speedstack inverts layer L8.

FR4 Core

PrePreg 1080

Copper Foil

Next, LPI solder mask is applied to the top side of the
stackup and reflected on the bottom side.

Copper Foil
FraPrg 1384

PrePrag 1080
Copper Foil
Liquid Photolmageable Mask

Ident layers (which are not considered components of
electrical symmetry) will not be automatically reflected by
Speedstack as they are added and must be applied
separately to each side of the board.

Select the upper solder mask and add an Ident material
above; select the lower solder mask and add an Ident
material below.

Screened Ident
Liguid Photolmageable Mask

LCopper Foil

Copper Foll

Liquid Photolmageable Mask

B Rl
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Assigning ground planes
e With all the material in place, assign ground planes; begin
} with layer L2 — it's reflected in layer L7. Right click the
SetLayerToPlane  copper (L2) in the top core and choose Set Layer to Plane.

PrePreg 1080

PrePreg 10

FR4 Core

PrePrag 1080

PrePreg 1080

FR4 Core

Repeat the process for the other ground plane layers; layer
L4 is designated a ground plane, the change is reflected in
L5 in the lower half of the stack.

PrePreg 1080

FR4 Car

PrePreg 1080

Secreened ldent
Liguid Photolmageable Mask
Copper Foil

PrePreg 1080
FR4 Core

PrePreg 1080

PrePreg 1080
FR4 Core

PrePrag 1080

PrePrag 1080
FR4 Core

PrePreg 1080

Copper Foil
Liquid Photolmageable Mask

Screened ldent
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Design rule checking

Speedstack includes facilities to check for errors in stackup
design, such as layers placed in invalid order or
asymmetrical structures. The condition of the design rule
checkboxes is carried over from session to session.

The Design Rule Checker (DRC) displays results in the DRC
dialog. As each design rule is broken the Speedstack
increments the error count on the DRC tab.

Viewing design rule errors
Click the DRC tab to view errors.

Stack Up Editer DRC:0 lCu:untn:uIIe-:I Impedance ] Cl Results ]

DRC Test Selection
[+ Design Logic v Symmetry [v Copper Balance
I¥ Board Thickness

[+ Manufacturing Tests

[+ Min. Trace \Width [v Min. Gap \width
Aspect Ratios

¥ Mechanical Drill I¥ Buried Laser Microvia
I¥ Elind Laser Microvia v Trace

[ Resin Starvation

The Design Rule Checker checks include checking for:

Two adjacent copper layers

Resin coated copper on internal layer

External prepreg layers

Internal solder mask material

Internal ident material

Internal peelable mask

Symmetry — different material types

Copper not balanced

Board thickness (if the board is outside tolerance the

Stack Information in the Stack editor is displayed in red)
Manufacturing tests

Minimum trace width (the test is carried out when
calculating controlled impedance)

Minimum trace separation (the test is carried out when
calculating controlled impedance)
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Drill aspect ratios for plated holes
Track aspect ratio
Excess resin test

If the Excess Resin check box is ticked values are shown as
below; scroll through the layers as required

Layer Resin

4]
> 1
2

10134.3%

2757.1%

Users can choose to display all errors or to select from a
combination of Design Errors, Symmetry errors and Copper
balance errors, etc.; check the boxes as required.

Click on the errors shown in the list to highlight the errors in
the stackup screen.

Resin Level Low:

Fesin Level Low: -100.0%
Resin Level Low: -100.0%
Resin Level Low: -100.0%

Errors are highlighted in red.

Faoil Copper Foil 1.400

PP PrePreg 1080 3.000 3.000

Core FR4 Core 300 3.000

Correcting design rule errors

Users are strongly recommended to work through and
correct errors in the order in which the errors are listed. Note
that clearing each error may clear other errors in the
process.

Manufacturing tests should be fixed before sending the PCB
for manufacture. Hole sizes should be adjusted to comply.
Failures with track and gap should be corrected, possibly by
changing prepreg thickness and/or dielectric constants.

A collection of manufacturing constraints can be defined and
the required one selected.
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Creating and using manufacturing constraints

From the Tools menu, select Manufacturing Constraints: the
Manufacturing Constraints window opens, displaying any
manufacturing constraints added.

Manufacturing Constraints

Manufacturer's Name Blind Laser ViaA R.| Buried Laser ViaA. | Mechanical Drill A. R. Minimum Gap Minimum Trace Width Trace A R.
Polar Mils . . . Mils

Polar Millimetres . . . Millimetres

Polar Inches

L.

Inches

Current Active Ci
’7 Highlight Set New

Close

By default there will always be at least one. It is important to
always have one constraint set active.

Editing constraints

Double-click on a constraint row will bring up the Edit
Constraints dialog; use the dialog to add, delete or edit
constraints (gaps, trace widths, aspect ratios, etc.)

Edit Constraints
Units
= Mils &+ Microns
" Inches " Millimetres
Option Name IF‘cIar Microns
Minimum Gap 75
Minimum Trace Width 75
Mechanical Drill AR. 8.5
Blind Via AR. 0.5
Buried Via AR. [0.5
Trace AR. f1
«< | < Tof 4 e
Add | Delete |
Done |  Cancel
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To edit a constraint set, use the navigation buttons to select
the set to be modified, change the values as required and
then press Done.

To delete a constraint set, use the navigation buttons to
select the set, then press Delete.

To add a new constraint set, press the Add button, this will
add a new (empty) constraint row, enter the name and
constraint values and press Done.
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Adding controlled impedance structures

Speedstack incorporates the facility to add controlled
impedance structures to a layer in the stackup.

Speedstack is integrated with the Polar Instruments
Si8000mM/9000e controlled impedance field solvers so
impedance values for a structure may be calculated at the
click of a button.

Structure parameters may be copied to the field solver for
processing (for example by the Si8000m/9000e Goal Seeking
function) and calculated values pasted back into Speedstack
for insertion into the stackup.

Each structure can be assigned up to five net class names.
These net class names provide a link to the matching
impedance nets inside the ECAD PCB layout system.

Adding a controlled impedance structure

For the example stack below, add a controlled impedance
structure to signal layer 4.

2.000
# 1.000
Screened |dent 2.000

3.000

Liguid Photolmageable Mask J
Copper Foil 0. 8,000

3.000

FR4 Core ’
2.000

PrePreg 1080

PrePreg 1020

VS I IV

FR4 Core ’
2000
PrePreg 1080 | g
/ 3.000

FR4 Core
1.000

PrePreg 1080

: - 2.000
. ) VA A 7 7 74
Copper Foil 0.
Liguid Photolmageable Mask J
Screened ldent 2.000

Sample stackup (showing signal layer 4 selected)

Note that in this example Layer 5 is a mixed signal/plane
layer. Potential reference planes for Signal Layer 4 are
therefore Plane Layer 2, mixed Signal/Plane Layer 5 and
plane Layer 7.
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With Layer 4 selected, click the Controlled Impedance tab.
The Add Structure button is displayed.

Stack Up Editor | DRC: 1 Centrolled Impedance | CI Resus |

+

Click the Add Structure button; the Structure Control dialog is
displayed containing the controlled impedance structures
applicable to the selected layer in the stack. Choose values
for the target impedance and tolerance. If necessary, resize
the Structure Control dialog to view all structures.

—Mumber Of Signal ———

Tracks = S |
" Single Trace Apply All |
o ) Edoge Coupled

Differential Offset Stripli...
" Brosdside ? Advanced |
Edge Coupled
(Cffset Stripli...
_ D Ofst. v
Target Impedance |1DD.1]
Target Tolerance % IH].U
Total of Structures Added jo
Primary Reference Plane |2 - I
Secondary Reference Flane |T Eez] |

Click the Single Trace, Differential or Broadside option button
as appropriate (in this case, choose Single Trace|Offset
Stripline 1B1A with a 50 Ohm impedance.)

Note: Broadside only appears as an option where the signal
trace is between two reference planes and Differential is
selected.

Specify the values for Target Impedance and Tolerance.
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Choosing reference planes

As there are multiple reference planes available (layers 2, 5
and 7, it will be necessary to specify which planes to use for
this structure. Click Advanced.

Plane(s) Above Signal Layer

Signal Layer = 4

Plane(s) Below Signal Layer

Caution: When using this option,
please ensure that the electncal
effects of any intervening power |
mixed planes are taken into
consideration

ok |  Cancel |

Choose a reference plane from the list of available planes. In
the example structure plane layer 2, mixed plane 5 and plane
layer 7 are available for reference.

Note: if plane layer 7 is chosen as reference, it will be
necessary to take into account the electrical effects of mixed
signal/layer plane 5.

In this example choose mixed signal/plane layer 5. Press OK
to confirm. The chosen reference planes are shown below.

Total of Structures Added |-|
Primary Reference Flans |2 Done |
Secondary Reference Plane |5 Cancel |

Repeat for all structures to be added. Click Apply for each
structure then click Done to finish. In this example, choose a
single structure.

- Layers with controlled impedance structures are indicated by
a red Ohms symbol.
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8.000

3.000

Core FR4 Core

—
2.000

PP PrePreg 1080

Core FR4 Core

The stackup window changes to reflect the selected signal
layer and its associated reference planes.

The applied structure is displayed in the Controlled
Impedance pane.

ipline 1E1A

Substrate 1 Height H1[aooo0
Substrate 1 Diglectric Er1 |4 2000

Substrate 2 Height H2 [iTooo0
Substrate 2 Dielectric E2[azo00
Lower Trace Width wi[ss085
Upper Trace Width wz [as213
Trace Thickness T1 |0.7000

Impedance Zofooo
Target Impedance [Fooo
Target Tolerance % [ooo

The window displays the parameters of the controlled
impedance structure. Fields shown "greyed out" are values
derived from the choice of materials in the stackup.

For this structure, enter appropriate values for lower and
upper trace widths.

Click the Calculate Displayed Structure button to display the
== impedance value of the structure with the current parameters.
Calculate Displayed The parameters may then be varied to alter the value of the
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Structure final impedance. In the example above the trace width can
be fine-tuned in order to approach the value of the target
impedance; other parameters are changed by modifying the
stackup dimensions (for example, core thickness H1.)

Hint: clicking Apply All in the Structure Control dialog adds a
single instance of all structures matching the stackup layer
and the chosen criteria; the designer can then choose the
structure producing the value nearest the target impedance
and delete the structures that are not needed.

Controlled impedance toolbar

Controlled impedance operations are performed via the
Controlled Impedance toolbar.

=X XOE0E S~ e
Al |I=:| c'm = | =l

Add controlled impedance structure to current layer

Delete structure from current layer

Clear all structures from current layer

QX | X| |4

Refresh and calculate impedance

Calculate displayed structure

Mirror structures

Goal seek

Set CITS test

Free hand notes

Structure layer properties

C)

Structure validation

31.} Structure Net Classes

L4 | I« ::'1011 =] =

Display layer and navigate

through structures
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Changing parameter values

Clicking the Calculate function yields a value for impedance.
Parameters (for example, the dielectric height) may be
amended to yield a value for impedance closer to the target
impedance.

For this example, select the core layers; click the Swap
Selected Material button and choose a different core (ensure
the same dimensional units are used throughout the
structure) and click the Refresh and Calculate Impedance
button. The impedance is recalculated to its new value.

To achieve an impedance acceptably close to the target
impedance, use the goal seeking function of the Si8000m to
alter other parameters (in this case, change the upper and
lower trace widths).

Goal seeking with Speedstack

Speedstack provides the facility to solve for horizontal
parameters (e.g. trace width and separation, ground strip
separation, etc.) to produce the target impedance (or
calculate that the target impedance is unachievable with the
current values).

Click the Goal Seek button to display the Set Up GoalSeek
dialog; the options available will depend on the controlled
impedance structure.

Set Up GoalSeek
Goal Seeking Parameter(s)
{# W12 only
~
~
~
" H1 Only

" H2 Only
~

~

QK Cancel

Click OK; the Speedstack attempts to arrive at the target
impedance by iteratively modifying the specified parameters.
It may be necessary to add or delete prepregs to achieve the
target impedance.
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Goal seeking with the Si8000m/9000e

Speedstack Stackup Builder is fully integrated with the
Si8000mM/Si9000e Controlled Impedance Field Solvers.
Users can transfer Stackup layer dimensions to the Field
Solver, solve for stackup parameters to produce the target
impedance (or calculate that the target impedance is
unachievable with the current values) then transfer the
solved dimensions back to Speedstack.

Ensure the Field Solver is running and that its units match
the Speedstack units.

With the stackup parameters displayed in the Controlled
_ Impedance window, click To Field Solver to transfer the
To Field Solver current Speedstack parameters to the Si8000m/Si9000e.

Switch to the field solver and click the Paste from
Speedstack button to load the parameters into the
Paste from associated field solver fields. The field solver reflects the

|71

Speedstack structure and parameters of that selected in Speedstack.
Tolerance  Minimum — kaximum
L. Substrate 1 Height H1 [ Booo0 <[ 00000 [ 50000 [ 60000 Calculate
Qfiget Stripling 1B1A Substrate 1 Dielectric En | 4.2nuoji| 00000 | 42000 | 42000 Calculate
Substrate 2 Height Hz2 | 90000 j [ o000 | 90000 | 9.0000 Calculate
Substrate 2 Dielectric B2 | 42000 j | 0ooon | 42000 | 42000 Calculate
Lower Trace Width W1 5.99?aji| 00000 | 59978 | 5.9978
Upper Trace Width W2 | o5m 3sji| 00000 | 50136 | 50136 Calculate
Trace Thickness T | 07000 j | 0ooon | 07000 | 07000 Calculate
Impedance Zo [ sooo [ 5000 5000 Calculate
Mare...

For the data shown above seek a final value for impedance of
50 Ohms; H1, Erl and T1 are fixed, so goal seek on W1,W2.

Click the Upper Trace Width (W2) Calculate button to goal
seek on trace width. The field solver returns new values for
trace width to produce 50 Ohms final impedance.

Lower Trace Width W1 5.aan?j,'i| 0.0000 | 59307 | 5.9307
Upper Trace Width W2 | 4_aan?ji| 0.0000 | 49307 | 49907

Click the Copy to Speedstack button, switch to Speedstack
and click the From Field Solver button to display the solved
Copy to Speedstack ~ parameters for the target impedance.

Note: it may be necessary to round some dimensions (for
example, the dielectric heights) to the nearest practical values
and recalculate the impedance.

“ I

From Field Solver
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Changing layer functionality

It is often convenient to base a new design on an existing
stackup and then add or remove electrical layers to create
the new stack, leaving the previous existing structures intact
or to switch between layer types (Signal, Plane, Mixed,
Hatched) without removing structures.

Speedstack allows the designer to retain and re-allocate
structures when changes are made to the electrical layers of
the stackup. This enables reallocation of structures after the
following stackup changes:

Adding foils and/or cores — increasing the layer count
Deleting foils and/or cores — reducing the layer count

Moving foils and cores up and down, even beyond
another copper layer — maintaining the layer count but,
for example, exchanging two different thickness cores
within the stackup

Copying and pasting foil or core — increasing the layer
count

Changing layer type — signal to plane, plane to signal,
mixed to signal or plane, signal to hatch, hatch to signal

Deleting a rigid core and adding a flex core — to maintain
layer count but swapping material type

Deleting a rigid core and adding two foils — to maintain
layer count but switching to an HDI type build

For the following examples, consider the stack below.

Liquid Photolmageable Mask 4.000

Copper Foil 0.700

PP PrePreg 1080 4200

1.950

Caore FR4 Core 4200

PP PrePreg 3080 4200

PP PrePreg 1651 4200

PP PrePreg 1651 4.200
Core FR4 Core 4200

PP PrePreg 1651
PP PrePreg 1651

PP PrePreg 3080

Core FR4 Core

PP PrePreg 1080
Copper Foil

Liguid Photolmageable Mask

4.000

1.950

0.700
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Switching layer types and reallocating structures

’ Switch signal layer 2 to a plane layer and plane layer 3 to a
Set Layer To Plane signal layer. Speedstack issues a warning indicating that

continuing with the change will require the existing structures
to be re-allocated.

Speedstack

I.-/"_"\-. This action will invalidate some or all existing structures, You will be
"Y' ableto check and re-allocate them afterwards using the Structure
Validation and Structure Layer Properties options. Do you wish to

proceed?

es Mo

Select Yes to confirm the change to the stackup. The stack
editor reflects the change in the stackup, layer 2 is a plane
layer and layer 3 a signal layer.

Liquid Photolmageable Mask 4.000
Copper Foil 0.700

PrePreg 1020 1.950

FR4 Caore

PrePreg 3080

PrePreg 1651

Speedstack also displays a flashing Rebuild indicator; due to
the changes to the stackup it is necessary to refresh the
structures.

=X XOE0E Y- el
Al ||=:| cl__>|i|

Click the Rebuild and Recalculate icon — Speedstack

displays an information dialog indicating which structures
need re-allocating.

Q

I.-/"_"\-.I The following structures require attention. Please re-allocate each
"W structure using the Structure Layer Properties option.

Layer: 1, Edge Coupled Coated Microstrip 18, 100 ochms
Layer: 1, Coated Microstrip 1B, 75 chms

Layer: 4, Edge Coupled Offset Stripline 1814, 100 chms
Layer: 4, Offset Coplanar Strips 1814, 30 chms
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Click OK then click the Structure Layer Properties icon to
reallocate the structures to the correct signal and plane
layers.

TXXOE0E L “e
ilili 1ofl —>|—> F!tructure Layer Pmperties|

The Structure Layer Properties dialog includes two layer
columns, the Current layer column and the New layer
column. The Current column shows the Signal / Plane
stackup layers assigned to the structure before the stackup
was changed.

The New column allows the structure to be re-allocated to
reflect the new stackup layer types.

Structure Layer Properties

Ipper Signal Layer |1 |-|

Lower Signal Layer I I

|Ipper Flane Layer |3 Iz

Ll Lef L Led

Lower Flane Layer I I

Structure: Inverted IFalse
Mumber of Structures on same Ig v Maove All

Signal / Plane Layers

Apply | Cancel |

In this case notice the Upper Plane Layer is changed from
layer 3 to layer 2.
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PrePreg 1651

Core FR4 Core

In many cases multiple structures will have the same Signal /
Plane layer assignments. In the example above Speedstack
indicates that there are two structures affected. Click the
Move All check box to re-allocate all matching structures in a
single operation then click Apply.

Rebuilding the stack indicates that other structures (i.e. the
two structures on layer 4) also require layer reallocation.

PP PrePreg 1651

I.-”'-_-'\-.I The following structures require attention. Please re-allocate each
W' structure using the Structure Layer Properties option.

Layer: 4, Edge Coupled Offset Stripline 1814, 100 chms
Layer: 4, Offset Coplanar Strips 1814, 30 chms

Use the structure selection arrow keys to step through to the
structures on layer 4 then click Structure Layer Properties.

Structure Layer Properties

ed Offset Stripline 1B1A
W2

Current Mew
Upper Signal Layer |4 |3 LI
Lower Signal Layer | I ;I
Upper Plane Layer |3 Iz ;I
Lower Flane Layer |E IE LI
Structure Inverted Im
St e T T Moen
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PP

Core

PP
PP
PP

Core

PP
PP
PP

Core

PP

Reallocate the layers as required then click Apply. With the
structures re-allocated Rebuild and Calculate the structures
as describer earlier.

Note that structure Trace Width and Separation parameters
are retained at their original values together with the Target
Impedance and Tolerance. (Depending upon how the
structures have been re-allocated it may be necessary to
goal seek the trace width and separation parameters to meet
the target impedance.)

Increasing the layer count

It is a common requirement for designers to base a new
design on an existing proven stackup and then add or
remove electrical layers to create a new stack, leaving the
previous existing structures intact.

Consider the 8 layer stack below.

Liquid Photolmageable Mask 4.000

Copper Foil

PrePreg 1020

FR4 Core

PrePreg 3080
PrePreg 1651

PrePreg 1651

FR4 Core

PrePreg 1651
PrePreg 1651

PrePreg 3080

FR4 Core

PrePreg 10380

Copper Foil

Liquid Photolmageable Mask 4.000

0.700

1.950

i

3.000
1.400
1950

0.700

For this example, add a core between layers 5 and 6.

Speedstack will display a warning that proceeding with the
change will require the existing structures to be reallocated.

I.-"- % This action will invalidate sorme or all existing structures. You will be
WY ableto check and re-allocate themn afterwards using the Structure

Validation and Structure Layer Properties options. Do you wish to
proceed?

Yes Mo
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PP

Core

PP
PP

Core

PP
PP

Caore

PP
PP

Core

PP

Press Yes to proceed.

In order to maintain a symmetrical stack, delete the Prepreg
3080 materials and add Prepreg 1651 materials to create a
symmetrical 10 layer stack.

Liquid Photolmageable Mask 4.000

Copper Foil

PrePreg 1080

FR4 Core

PrePreg 1651

PrePreg 1651

FR4 Core

PrePreg 1651

PrePreq 1651

FR4 Core

PrePreqg 1651

PrePreg 1651

FR4 Core

PrePreg 1080

Copper Foil

0700

1.950

4200

4200 1.950

0700

Liquid Photolmageable Mask 4.000

Click Rebuild and Recalculate

Speedstack displays an information dialog indicating the
structures that need reallocating.

Speedstack >

b The following structures require attention. Please re-allocate each
/' structure using the Structure Layer Properties option,

Layer: 4, Edge Coupled Offset Stripline 1814, 100 ohrms
Layer: 4, Offset Coplanar Strips 1B14, 30 chms

oK

Click OK.

Use the structure navigation buttons to select the structure
layer then click the Structure Layer Properties button to
display the Structure Layer Properties dialog.
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Structure Layer Properties

Edge Coupled Offset Stripline 1B1A

— e

5 W2
- -
i i

Upper Signal Layer |4 |4 j

Lower Signal Layer | | J

lpper Flane Layer |3 |3 j

Lower Plane Layer |E |E j

Structure Inverted False

Mumber of Structures on same

Signal ! Flane Layers 2 ¥ Move All
Apply | Cancel

Note that for the modified stack the lower plane layer has
been reallocated to layer 8.

Click Apply and then Rebuild and Recalculate.

If necessary, goal seek on line widths to bring the impedance
within specification.

For the above stack edit the Drill Properties to finalise the
stack changes.

Repeat the procedure for each structure as necessary.

Structure net classes

Speedstack allows up to five Net Class names to be stored
with each structure. These net class nhames provide a link to
the matching impedance nets inside the ECAD PCB layout
system. Net classes are supported in Speedstack’s import /
export file formats.

Net class columns can be selected for display on the
technical report.
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T To display the Structure Net Classes dialog click the Net
Net classes Classes button

Enter the net class names in the text boxes and click Apply.

Structure Met Classes nl
Met Class 1 TX0
Met Class 2 TX1
Met Class 3 R0
Met Class 4 RX1
Met Class &
Apply | Cancel |

Up to five net class names may be stored with each structure.

ﬂ”é' Click the Select Impedance Columns button and Select the
2 Net Class columns to display the net classes on the
Speedstack technical report.

Select Impedance
Columns

g= Select Controlled Impedance Table Celumnns — O *
Selected Columns Auwailable Columns
Impedance Signal Layer ~

Broadside 2nd Layer

Ref. Flane 1in Layer
Trace Pitch {51+ W1)

Ref. Flane 2in Layer

|

Lower Trace Width (W1) Lower Ground Strip Width (G1)
Upper Trace Width (W2) Upper Ground Strip Width (52)
Trace Separation (51) Trace Offset (01)

Target Impedance Ground Strip Separation (D1)
Tol (+/- %) Substrate 1 Height (H1)

Calculated Impedance Down Substrate 2 Height (H2)
Substrate 3 Height (H3)

MetClass2 Delete Substrate 4 Height (H4)

NetClass3 4' Substrate 1 Dielectric (Er1)

MetClassd Clear Al | Substrate 2 Dielectric (ErZ)

MetClasss hd Substrate 3 Dielectric (Er3) b
oKk | cancel |

The chosen columns are displayed in the selected order.

Lawer | Uppar
Impadance | Raf, Raf. Trace | Traoe Trace
impadances | Structurs | Sigral Pane 1 | Plans 2 | Width | Width | Separation | Targel | Tol (= | Calkculated
[I+] Imag Layar i Layer | inLayer | (W1} | [W2) (813 Inpacancs| %) | impedance § MetClassl | MeeCiasa2 | MeiCiassd | MeaClass4 | MeClasas

1 : 1 3 a BI2a 7224 a.3m 100. 000 10,000 95930 T 0 ™ RXO RX1
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Working with Si Projects in Speedstack and Si8000m/Si9000e

Si Projects

The Si Projects feature incorporated in Speedstack and
Si8000m and Si9000e v15.10 and later allows for easy
transfer of controlled impedance structures from the
Speedstack stackup design tool into the Si8000m and
Si9000e field solvers.

Si Projects allows groups of structures to be saved and
recalled in Si8000m and Si9000e and entire stackups of
structures to be pasted from Speedstack into Si8000m and
Si9000e with just a few clicks of the mouse.

The To Si Project toolbar icon copies a group of structures
from Speedstack and places them onto the clipboard, these
structures can then be pasted directly into the Si8000m /
Si9000e Project group.

b

Transferring structures from Speedstack to the field
solver

The stackup below in Speedstack's Stackup Editor contains
controlled impedance structures in the layers indicated by
the Ohms symbol.

Liquid Photolmageable Mask 4.000
Copper Foil 0.700
PrePreg 1080 4200
FR4 Core 4200
PrePreqg 3080 4200
PrePreg 1651 4200
PrePreg 1651 4200
FR4 Core 4200
PrePreqg 1651 4200
PrePreqg 1651 4200

4200

FR4 Caore 4200

PrePreg 1080 4.200

Copper Faoil 0700

Liquid Photolmageable Mask 4.000
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Click Speedstack's Controlled Impedance tab and use the
structure navigation controls to step through and display the
structures.

e[| <fiors >[5

Use the Si Projects toolbar buttons in the Speedstack and
the Si8000mM/Si9000e interfaces to transfer the structures via
the Windows clipboard to the associated field solver.

b

Switch to the field solver and paste the structures from the
clip board into the field solver Si project.

Al

|Paste?r|:|m Speedstack into 5i Project

The complete set of structures appears in the field solver’'s
Project window. The Si Project window lists the transferred
structures in layer order, showing the layer number and
value along with a thumb nail graphic indicating the structure
configuration. Right click on a structure in the structure list to
view the structure options.

Add Structure to Project
Delete Structure from Project

Renarne Structure within Project

Move Up

Move Down
Duplicate Selected Structure

Clear Project

Demo Mode : Load Sample Structures into Project
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Adding/deleting and modifying structures

Selecting each structure displays its associated graphic in a
grey background.

L1100 ahms (1]

L1 75 ahms [2]

L4 100 ohms [3]

L4 50 ahrns [4]

L& 75 ahms [5)

Click the + and — buttons in the structure graphic to add
additional structures from the Si structure library or remove
selected structures from the Project folder. Click the Rename
Structure (the pencil icon) to assign the structure a
descriptive name.

+| -]~

L1 100 ohms (1)

With a structure selected the structure parameters can be
modified as required and the impedance recalculated.
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Creating CITS test files

& Set CITS Test

Speedstack can create CITS test file data for each controlled
impedance structure in the stack.

Select each structure and click Set CITS Test to display the
Edit Test data dialog; specify the CITS test parameters for
each structure to be tested and click OK.

Edit Test data
— Structure Details —Channel Select
Structure Description |Offset Coplanar Strips 1B1A
| {* Single Ended Probe 1D
Impedance 50.00 T -
{" Differentia Sl
Signal Layer | 4
—Herizontal —Vertical
i Inches -
Units ! = Ohms/Division 10 -
Test From |3
— Tolerance
Test To 7
¥ Locked
Test Method [Absolute |
- Plus Im i
p
i |1 0 2
% Default LTS -
" User

Exporting the CITS test file

With the test data specified for each structure, from the File
menu choose Export To|Export CITS File. Add descriptive
Board Details and notes as required.

Customer IF‘oIar

Board Type IGEII'HB back plane
Fart Mumber |1234

Revision Mumber IHE'u' 06

Click Make File and navigate to a suitable folder and save the
CITS (.cif) test file.
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Working with flex-rigid stackups

Speedstack Flex

Speedstack Flex allows PCB fabricators and OEM engineers
quickly to create and document accurate and efficient flex-
rigid PCB layer stackups.

The graphical stackup display

The Speedstack Flex Navigator enables the board designer
to link and document as many cross sections as necessary
in order to fully document a flex-rigid build up.

Speedstack Flex supports documentation of common flex-
rigid constructions, including doublets where stacked pairs of
flex link two rigid sections of the flex-rigid construction
together (see graphic below.)

Speedstack’s Navigator works from a master stack
comprising the full set of materials used in the final stackup
and documents each rigid and flex-rigid section with as many
"sub-stacks" as needed for the design. There are no limits to
the number of sub-stacks or layer count of the total build.

A range of materials including flexible adhesives, bondply
and FlexiCore can be enabled or disabled for each layer, and
impedance structures can be added to each sub-stack.
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PP

PP

Core

PP

PP

Core

PP

PP

Mesh / Crosshatch ground planes

When used with Polar’'s Si8000m and Si9000e field solvers,
Speedstack Flex permits modelling and documenting
mesh/crosshatch ground planes from within the Speedstack
Flex environment. Mesh geometry and structure data can be
easily shared between Si8000m and Si9000e.

Internal Coverlays

Advanced rules allow impedance structures to be added
when coverlays exist internally within a stack. When a
coverlay is beyond the outer copper it will behave like a
coating, when internal it will behave like a bondply or prepreg.

Definable colours per material

Speedstack Flex can set and store individual material
colours via the material Properties dialog. This will help
ensure that special build requirements are obvious during
fabrication. This will be found useful for documenting plated
layers or highlighting specific material usage such as no-flow
prepregs and flexible cores.

Enabling Speedstack Flex/HDI
To enable Speedstack Flex/HDI select Tools|Options and

ensure the Licensing pane purchasable option Speedstack
Flex/HDI License check box is ticked.

Adding a flexible core
Create and save a symmetrical 6-layer stackup as shown in
the sample stack below

Liquid Photolmageable Mask 1.000 1.000

Copper Foil
PrePreg 1080

PrePreg 1020

FR4 Core

PrePreg 1080

FR4 Core

PrePreg 1080
PrePreg 1080

Copper Foil

0.700

3.000 3.000

3.000 3.000

0.700

8.000 8.000

0.700

3.000 3.000
3.000

0.700

3.000 3.000

0.700

3.000 3.000

0.700

Liquid Photolmageable Mask 1.000 1.000
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Ensure Symmetrical mode is off, right click the prepreg
above Layer 4 copper and add a flexible core:

0.700
Core FR4 Core 8.000 8.000

PP PrePregi1030  3.000 3.000

PP PrePreg1080  3.000

Add Foil
Core FR4Core 8000 Add C.I. Structure Loz
Sl re b e e [EES
PP PrePreg1080 3000 . Flexible Core
Set to Signal |
aPreq 1020 Bondply
PP PrePregi1080 3000 L. Set to Plane o

PrePreg 1020 3.000

Flex Core 3.000 3.000

PrePreg 1080 3.000 3.000

Using the Navigator
Press F4 to display the Navigator

. Decking

Colours

Refresh

Right click the Navigator and choose Docking|Float to allow
the Navigator window to be resized. The Navigator will move
with Speedstack’s Stack Editor. Choose Free to allow the
Navigator to move independently of the Stack Editor.

Adding stacks

Select the stack in the Navigator window and click Add Stack
and choose Defined by Layers
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Select Stack

Add Stack 2 Duplicate Master

Remowve Stack . Defined by layers

From the drop-down list choose Layer 4 as the Top Layer
and Layer 5 as the Bottom Layer as shown below and enter
Flex as the Substack Root Name.

Top Layer |4 ;I
Bottom Layer I 5 LI
Position Stack
Far Left Left Right Far Right
i i o i
Substack Root Name IFIE:.;
Apply | Cancel

The new stack is added to the Navigator. Each sub-stack
can be renamed individually as required.

Click the new stack — the selected stack is reflected in the
Stack Editor and listed in the status bar. Select Symmetrical
mode, in the Stack Editor click the new core and add a
coverlay above.
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FC

Clay

Flex Care

Coverlay

3.000

The coverlays are added symmetrically about the core.
Changes made in the Stack Editor are reflected in the
Navigator. Click into the Navigator — use the mouse wheel to
resize. The Navigator can display in 2D or 3D views.

The new stack with its added materials appears in the
Navigator; clicking each stack in the Navigator displays it in
the Stack Editor and allows editing as described earlier to
add controlled impedance structures, change layer types,
add non-copper layers, etc.

Adding a new stack

Right click the Navigator and choose Add Stack|Duplicate
Master, rename the new stack and click OK.
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The new stack is added to the Navigator. Click on each stack
to display it in the Stack Editor and then edit as required.

Defining new stacks
New stacks may be added defined by layers of the master
stack. Choose Add Stack|Defined by Layers:

| Add Stack F Duplicate Master
Remuowve Stack | Defined by layers |

Top Layer |3 LI

Bottom Layer Celect Layer -
4

Position Stack —|5
[
Far Left 7 Far Right
I
i« 9 "

10

Substack Root Name |Master

Apply | Cancel |

Choose the starting and finishing layers and specify a
position for the new stack, choose a descriptive sub-stack
root name and click Apply.

Copying and pasting stacks

To copy a stack in the Navigator select the stack, choose
Copy and Paste Stack, then from the dialog below choose
the position of the new stack
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Position new stack...

Far Left Left Right Far Right
i i i i

Apply Cancel

Removing stacks

To remove a stack right click the Navigator, choose Remove
Stack and select the stack to be removed.

= =

SubStack01
SubStack 2

Aligning materials in the navigator

On occasions, adding a flexible stack results in misalignment
between layer materials displayed in the navigator, for
example, between the bondply and coverlay layers and the
associated prepreg layers — see the graphic below.

To move the layers into alignment, select the stack in the
Stack Editor and use the FlexNav Move Up and FlexNav
Move Down commands from the Edit menu.

In the example above select the flexible stack in the Stack
Editor, select the upper Coverlay layer and shift the layer up
into alignment with the prepreg layer in the rigid stack (use
the Ctrl + Shift + Up arrow keys)
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Repeat the alignment for the bondply and lower coverlay
materials (using the Ctrl + Shift + Down arrow keys.) The
materials are displayed aligned in the navigator — below.

From the Edit menu Reset All NVDP (Navigator Visual
Display Position) Attributes to return the stack to its original
alignments.

The navigator display is reproduced in the Technical Report

-
2
| | |

B w
I oo

[+2] 4]
e m—

e} ~l
|

Master flex Sub_stack 3

The technical report also supports different materials on the
same dielectric layer, improving the clarity of documentation
between the stackup designer and fabricator.
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Displaying the stack in Proportional View

Speedstack can display the stackup so that the material
thicknesses are shown proportional to each other. Select the
stack in the Stackup Editor and from the View menu choose
Proportional Stack Viewer.

4.000 1.000

2.800
4.260 20.000

1.400
3.940 5.000

3.940 5.000

1.400
2.900 4.000
1.400

3.770 4.000
1.400

2.900 4.000
1.400

3.540 5.000

3.940 5.000
1.400

4260 20.000
2.800

4.000 1.000

This visual aid will be found useful when considering the
dielectric thicknesses between electrical layers.
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Using the Ruler within Proportional view
Select the stack in the Stackup Editor

63.500

101.600

76.200

101.600

Switch to Proportional View and click the ruler on.

Distance: 76.29846 ym

Zoom in as required and use the ruler to measure material
dimensions, thicknesses, trace widths, etc.
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Working with HDI builds

Speedstack HDI

For HDI PCB fabricators, Speedstack HDI provides the
flexibility to quickly calculate the possible impact of
substituting alternative materials to improve manufacturability
and reduce cost while maintaining the specified parameters
and performance of the board.

Easy graphical stackup display

The HDI navigator provides a rapid guide through the
sequential sub-stack lamination sequence and presents the
complete assembly in a parsed graphical display that shows
each phase of the multi-step lamination sequence of an HDI
PCB. User-definable settings within the navigator allow
engineers to display layers in transparent, invisible or 3D
mode.

Sub-stack reordering

Speedstack Navigator makes re-ordering and renaming sub-
stacks quick and easy in HDI builds; sub-stacks can be
simply moved left or right within the Navigator window.

HDI builds
Use the Speedstack Navigator to document HDI press/drill

cycles. Speedstack can document press cycles based on foil
locations or drill start and end layers.

Sequential plan

The Sequential plan command creates sub-stacks that
represent each press cycle in a sequential lamination from
the Master stack based on foil locations.

Drill plan
Using Drill Plan, Speedstack determines the sub-stacks by
the start / end layers of the drills.

Creating the target stack with the Stack Editor

Consider the target stack below — it will require three press
cycles. Build and document the stack in the Stack Editor.

Switch to 2D View.
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Liquid Photolmageable Mask
Copper Foil

PrePreg 1080
Copper Foil
PrePreg 1080

FR4 Core

PrePreg 1080
PrePreg 1080

PrePreg 1080
FR4 Core

PrePreg 1080
PrePreg 1080
PrePreg 1080

FR4 Core

PrePreg 1080
Copper Foil
PrePreg 1080

Copper Foil
Liquid Photolmageable Mask

With the target stack completed use the Navigator's Add

Stack to document each press cycle, building up the stack in
the Navigator. Press F4 to start the Navigator and display the
master stack.
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Click Add Stack to copy the stack and name the new sub-
stack Press cycle 2.

Stack Mame |F‘ress cycle 2

—Board Thickness

Target Stack Up Thickness IEE.BTH'E'I
Positive Tolerance % I'H]'
Megative Tolerance % I'H]I

—Copy into new stack. . . .

v Impedance Structures
[V Motes

[~ File Properties

QoK Cancel

The new sub-stack is copied into the navigator window

Click the sub-stack to display it in the Stack Editor. In the
Stack Editor add the drills and disable the materials that are
added in the final press cycle.
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PrePreg 1020
Copper Foil
PrePreg 1080

FR4 Core

PrePreg 1080
PrePreg 1080

PrePreg 1080
FR4 Core

PrePreg 1080
PrePreg 1080

PrePreg 1080
FR4 Core

PrePreg 1080

Copper Foil

The Navigator displays the second press cycle alongside the
master stack.

The sub-stack can be displayed either to the right or left of
the master stack. Right click the sub-stack and from the
context menu choose Move Left.
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Sub-stack Press cycle 2 is shown to the left of the master.

Fress cycle 2

To add the first press cycle right click the sub-stack and
choose Copy and Paste Stack and position the new sub-
stack to the far left.

Position new stack. ..
Far Left Left Right Far Right
o [ [ [
Apply Cancel |

Modify the new sub-stack in the Stack Editor as previously
described and display the completed stack in the Navigator.
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Each press cycle appears as a separate stack in the
Navigator.

In the fabrication process the manufacturer will process all
the core materials first, prior to bonding where each core is
interleaved with prepreg materials. It is sometimes useful,
therefore, to see all the core materials on a single sub-stack.

Right click the Navigator window and choose HDI
Build|Expose Cores to display the core layers.
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Using the Sequential Plan

Sequential Plan creates sub-stacks that represents each
press cycle in a sequential lamination from Master stack
based on foil locations. Consider the 14-layer stack below —
this stack will need several press cycles to manufacture.

Liguid Photolmageable Mask

e //////
Copper Foil

FR4 Core

PrePreg 1080

FR4 Core

PrePreg 1080

Copper Foil

Liguid Photolmageable Mask

Opening the Navigator will display the completed master
stack (shown below) in the Navigator window.
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Right click the Navigator window and choose HDI Build
|Sequential Plan and name the sub-stacks:

Substack Root Name |Press Cycle

Mo Elind Mechanical Vias v

fpply | Cancel |

Click Apply — the Navigator displays the 4 press cycles

Press Cycle 2

Choose HDI Build|Expose Cores — the cores are displayed in
the Navigator window alongside the press cycles.
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Liquid Photolmageable Mask

Copper Foil
PrePreg 3113
Copper Fail

PrePreg 1080
FR4 Core

PrePreg 1080

PrePrag 1080
Copper Fail
PrePreg 3113

Copper Fail

Using the Drill Plan

The HDI Build|Drill Plan creates sub-stacks that represents
each press cycle from the Master stack based on drill start-
end layers. Consider the stackup below — a 10 layer
sequential lamination construction.

‘ o
" S ST
.

Liquid Photolmageable Mask

Master

The completed Master stack is displayed. Right click the
Navigator and choose HDI Build|Drill Plan.
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HO! Build J Sequential Plan
. Drill Plan |

Expose Cores

Rename Stack...

Supply the Sub-stack root name — the name willl be used
when numbering the press-drill cycles.

Substack Root Name |Press-Drill Cycle |

Mo Elind Mechanical Vias v

fpply | Cancel |

Click Apply — Speedstack documents the build-up stages of
the sequential lamination.

Press-Drill Cycle 02

Exposing cores
Right click the Navigator and choose HDI Build|Expose
Cores — the cores are shown alongside the press cycles.

There are no limits to the number of press cycles that may
be documented.
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Working with multiple press cycles
The stack below is a 24 layer stack with multiple press-drill
cycles. Open the Navigator, choose HDI Build|Drill Plan.

Printing the Navigator screen

From the File menu choose Print Technical Report —
Speedstack prints the Navigator screen with its press cycles
along with individual stack data, impedance data and drill
data tables.
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Using Speedstack materials libraries

The materials libraries allow designers to manage their own
libraries of board materials.

Click the Materials Library button to display the Materials

jﬁ Library window.

Materials Library

Working with the materials libraries

When Speedstack is started the materials library specified as
the default materials library file (via Tools|Options|File
Locations) is opened.

File Locations |

Select default matenals library file

C:\Program Files (x88)\PolariSpesdstack\Samples\Speedstack Impenal mibi Browse...

Each library component type is accessible via its associated
tab. Click on the tab to view or edit the component type.

HE c\Program Files (x36)\Polar\Speedstack)Samples\Speedstack Imperial.mlbx O ks

il B EEEERT %

Fails ] Prepregs] RCCs

] Solder Masks ] Idert Inks ] Peelable Masks ] Coverays ] Bond Ph.'] Adhesive | Fexible Cores

Supplier Supplier Description Description Stock Mumber Dielectric Base Thickness | Dielectric Finished Thickne| Dielectric C:nnstan
3 PolarSamples Co/o1 FR4 Core 400-001 2 2 432
PolarSamples C0/002 FR4 Core 400-002 2 2 42
PolarSamplas COoin03 FR4 Cora 400-003 2 2 432
PolarSamples COoin04 FR4 Core 400-004 3 3 42
PolarSamples COroos FR4 Core 400-005 3 3 42
PolarSamples CO FR4 Core 400-008 3 3 42
PolarSamples C FR4 Core 400-007 4 4 42
PolarSamplas FR4 Core 400-008 4 4 42
PolarSamples FR4 Core 400-009 4 4 42
PolarSamples FR4 Core 400-010 5 5 42
PolarSamples FR4 Core 400-011 5 5 432
PolarSamples FR4 Core 400-012 5 5 42
PolarSamplas FR4 Cor 400013 =] 6 42
PolarSamples FR4 Core 400-014 =] 8 42
PolarSamples FR4 Core 400-015 3] 8 42
PolarSamples FR4 Core 400-016 g 8 42
PolarSamples FR4 Core 400-017 8 g 42
PolarSamplas FR4 Core 400-0128 2 2 42
PolarSamples FR4 Core 400-013 12 12 42
PolarSamples FR4 Core 400-020 12 12 42
PolarSamples FR4 Core 400-021 12 12 432
PolarSamples FR4 Core 400-022 21 21 42
PolarSamplas FR4 Cor 400-023 2 21 42
PolarSamples FR4 Core 400-024 21 21 42
PolarSamples il FR4 Core 400-025 39 39 432
PolarSamples U FR4 Core 400-026 39 39 42
J PaolarSamples 027 FR4 Core 400-027 39 39 42 f

The Materials Library is managed via its toolbar.
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Materials library toolbar

Use the toolbar to load and save libraries, import or export
libraries, arrange data columns and filter by data field. The
Toolbar is shown below.

T ™ Vi Y| g

Exit Library

Clear Materials Library

Open Materials Library

Save Materials Library

Import CSV Library

E Export CSV Library
—=1 Select & arrange Column fields

Save column order

Load column order

Set Filter

Clear Filter

Library Lock

Creating a new library

To create a new library, click Clear Materials Library; the

Clear Materials library is removed from the library manager.

Library Click Save Materials Library to create the new library. To
have the library load as the Speedstack starts, specify it as
the default materials library file via Tools|Configuration

Save Materials Options|File Locations.

Library

Using Speedstack materials libraries e 113



Adding material to the library
Caution: ensure consistency of units

When defining dimensions, e.g. layer thicknesses, for a
stackup ensure that all measurements are defined using the
same units (mils, mm, etc) throughout the structure and its
associated libraries.

Open the library to be modified. To add materials to a library
click the associated component type tab; click onto a
material, or empty line. An editing box will open which will
contain the material clicked on, or the last material in that

type library.

Supplier Size I‘
Supplier Description |COI'DD‘| Note 1
Description |FR4 Core
Stock Number |400-001
Type |FR4

Mote 2
Base Thickness |2.0000
Finished Thickness {2.0000
Dielectric Constant |4.2 Note 3
Resin Content |75
Tg {120
Td o
CAF Resistance [o ote 4
Z Auis Expansion o
Tolerance +-% |'H]

Note B
Upper Cu Thickness {0.7000
Lower Cu Thickness {0.7000
Cost |1
Lezd Time o
Use in Auto Stack v
Planes Both Sides v
Laser Drillable v

Add Delete << < 1of 30 > Ed OK |

The material can be edited or deleted, or a new material can
be added. To speed up the process of adding families of
materials, when a material is added the properties of the last
material are copied to the new material. The details can then
be edited. Clicking OK will add any new materials to the end
of the list.
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E=z
= .
Import CSV Library

Importing material to the library

Speedstack allows users to add existing material lists to its
library; material data must be arranged in the format and
order used by the Speedstack library.

Sample files in comma separated value format and Microsoft
Excel spreadsheet and template formats suitable for
importing to the Speedstack are included in the Speedstack
Material Library Import folder.

Click the Materials Library button to open the Library, and
then click Import CSV Library to open the Import dialog.

—Delimiter ——————— ~File Type
Fails
i~ Tab RCC
PreP
" Comma —
n SolderMasks
¥ Other dents
I— Peelables
Coverays
BondPhy
— Units for Import Adhesive
FlexCaores
i Microns
¥ Mils/Thous
i Inches
™ Millimetres
i Metres

% Start New Library
" Lppend To Existing Library

Apply | Oone Cancel

Choose Start New Library or Append to Existing Library as
appropriate.

Creating a new materials library
Choose the Start New Library option and choose the field
delimiter type.

The library import function can accept files in a variety of
formats, tab delimited, comma separated and Excel
worksheet and template formats.

Sections of the sample files suitable for Speedstack are
shown below.
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A B £ D E F G H 1

1 "Cores!

2 |* Dielectric Dielectric

3 *Type Supplier Supplier Description Description Stock Number Upper Cu Thickness Lower Cu Thickness Base Thickness Finished Thickness

4 |FR4 Polar Samples CO/001 FR4 Core 400-001 0.018 0.018 0.05 0.05

5 FR4 Polar samples C0O/002 FR4 Core 400-002 0.035 0.035 0.05 0.05

6 FR4 Polar Samples CO/003 FR4 Core 400-003 0.07 0.07 0.05 0.05

7 FR4 Polar samples CO/004 FR4 Core 400-004 0.018 0.018 0.075 0.075

8 FR4 Polar Samples CO/005 FR4 Core 400-005 0.035 0.035 0.075 0.075

9 FR4 Polar samples CO/006 FR4 Core 400-006 0.07 0.07 0.075 0.075

10 |[FR4 Polar samples CO/007 FR4 Core 400-007 0.018 0.018 0.1 0.1

11 |[FR4 Polar samples CO/008 FR4 Core 400-008 0.035 0.035 0.1 0.1
Sampile library file in Microsoft Excel format

* Cores

333333333333033333303333
*,112222,0ielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,,,,,,,,

*Type,Supplier,Supplier Description,Description,Stock Number,Upper Cu Thickness,lLower Cu Thickness,Base Thickness,Finished Thickness,
Content,Tg,Td,CAF Resistance,ZAxisExpansion,ExcessResin,Tolerance,Cost,Lead Time,Notes 1,Notes 2,Notes 3,Notes 4,Notes 5,5ize
FR4,Polar Samples,C0/@@1,FR4 Core,400-001,0.018,0.018,0.05,0.05,4.2,75,180,0,0,0,08,10,0,8,,,,,,*

FR4,Polar Samples,C0/@02,FR4 Core,400-062,0.035,0.035,0.05,0.05,4.2,75,180,0,0,0,0,10,0,8,,,,,,*

FR4,Polar Samples,(0/@03,FR4 Core,400-8083,0.87,0.07,0.05,0.85,4.2,75,180,08,0,0,0,10,0,8,,,,,,*

FR4,Polar Samples,C0/@04,FR4 Core,4100-004,0.018,0.018,0.075,0.075,4.2,60,180,0,0,0,0,10,08,8,,,,,,*

Sample library file in comma separated format

Files for importing into the library must be in the above
format, with columns in the correct order.

Specify the delimiter if necessary and choose the file type
(Foil, RCC, Prepreg, etc.) and units for import and click
Apply. Choose the file from the list displayed in the Open
dialog and click Open. Repeat the procedure for every file
type; Click Done when all file types have been imported.

Save the file as a .mlbx library file.

Adding material data to an existing library

To add material data to an existing library, open the library
click Import CSV Library, click the Append to Existing Library
and click Apply. Choose the .csv or .txt file and click Open
then click Done. Save the modified Library file as a .mlbx file.

Selecting Materials from the Library

Column Order (Materials Library)

The default setting displays all columns. The columns
displayed and the order they are displayed can be set in the
materials Library form.

Arranging Columns in Library Forms
The Library windows can be customised in respect of which
columns to display and in which order.

Columns; the dialog associated with the selected material

e Click the Go to Materials Library button and select Arrange
Arrange Columns tab (Foils, Prepregs, etc.) is opened.
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Save Column Order

Load Column Order

Yo,
.Set Filter

Selected Columns Available Columns

Supplier ~
SupplierDescription

Description .
Stock Number =
CuThickness
Type U
Cost
LeadTime o
UselnfAutoStack own
Note1

Note2 Delete
Noted

Noted
Nata5 o Clear All

i

i

ok | Cancel |

The Left box of the dialog shows the columns that will be
displayed and the order top to bottom is the order they will be
displayed left to right in the library window.

Click OK to return to the Materials Library, which will show
the columns as set.

Until the column order is saved the column order is only
available during the current session. Click Save Column
Order to define the selected column order as the default
order whenever the program is run.

Click Load column Order to apply a saved column
arrangement.

Filtering Materials

When adding or swapping materials, available materials
(Foils, Prepregs, etc.) are listed in the associated material
library dialog. Lists can be filtered for materials matching
desired parameters (dielectric thickness, Er, etc.)

In the library window click the Set Filter to display the Set
Filter String dialog.

Set Filter String

Dielectric Finished Thickness d |<= LI |7| IAND LI
Field | Operand | Criteria | AND/OR
» Dielectric Finished Thicknes == 5 AND
Dielectric Finished Thicknes <= 7 (null}
*
ki 2
up | Down Delete Row Clear All |
Dielectric Finished Thickness »= 5 AND Dielectric Finished Thickness <=7

FinishedThickness >= 5 AND FinishedThickness <=7

Save Filter | Load Filter | ok | cancel |
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Filter strings can be created and saved for future use. To
save click Save Filter, to recall an existing filter click the Load
Filter button, choose the filter (.mlf) file and click OK.

Building the filter string

Build the filter string by selecting parameters, operands and
criteria from the drop-down boxes. If the AND/OR box is
selected another row is automatically added to the grid. The
filter language is a sub-set of common database commands.

Use the Up/Down buttons to select a row for deletion. The
arrowhead at the side of the grid indicates the selected row.

Click OK to apply the filter immediately to the selected
library. If desired, save the filter string for future use. (The
Speedstack provides for interaction between the library
dialog and filter form. This allows complex strings to be built
line-by-line and tested without saving until the string is
completed.)

When saving the filter choose a descriptive name for the file
that reflects the purpose of the filter. The Speedstack
automatically names the files for the material type.

Using the Like operator

Use the Like operand to filter results via wild card characters.
The characters * and % can be used to represent groups of
starting or ending characters.

For example, specifying Like ‘Po%’ or ‘Po* as the criterion for
the Suppliers field will show all suppliers beginning with ‘Po’.

Similarly, specifying Like ‘%es’ or “*es’ as the criterion for the
Suppliers field will show all suppliers ending with ‘es’.

'v Click the Clear Filter to remove the filter and display all
Clear Filter materials of the selected type.

Locking the library

The materials library can be locked and password protected
to prevent unauthorised or accidental editing. If no password
has been set the Material Library remains open for any
changes and modifications.

Library Lock

To lock the library, click the Library Lock button and supply a
password; the library is then locked and any editing requires
the password to be entered (via clicking on the padlock).
Once unlocked it will remain unlocked until Speedstack is
closed or the padlock is clicked again.
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Printing stackup information

To print the stackup information, choose the Print command.
Print Technical Report includes stack details, controlled
impedance structures, drill specifications and information
entered into the Stack File Properties.

&5 Speedstack Report Printer

File Options

S M EEEEE

A - Ak R

h - () x

) (=) =& [ I}
d‘)\ L es (D0 GH Display Page |1 -

CAProgram Files (x86)

L] L

Supplier Processed|  Mask Copper | Base Finish Isolation
Layer Stack up. Description Description Type | Thickness | Thickness | Color | &r | impedance ID | Coverage | Thickness| Thickness| Resin Content| Distance
I  Liquwd Photoimageable Mask  SMI0OT 500001 Soldertask 1,000 Green  4.000
1 ] M M A M corperrol Foro1 100001 Copper 0700 1.2 0.000 0700 0700
PrePreq 1080 PRI 300001 Dielectic 1850 4200 3000 3.000 50,000 1850
2 1400 0.000 1400 1400
FR4 Core €005 400005 F 3.000 4200 3000 3000 50.000 2008
] 1400 0.000 1400 1400
e E ) sRi02 300-002 Diclectic 2775 4200 3.000 2000 50.000
I — R T PRI 300-004 Dieleciic 5552 4200 6000 £.000 47.000
] PrePreg 55t PPIG04 300004 Dielecic 5552 4200 6000 6000 47000 5552
4 S 1400 3.4 0.000 1400 1400
2 FR4 C ©0i020 400020 FR4 12000 4200 12.000 12.000 46.000 12.000
5 2 1400 0.000 1400 1400
T PrePreg 65t FRi04 300-004 Dielectic 5552 4200 6000 €000 47.000 5552
— T R PRIO04 300004 Dislec 5552 4200 5000 6000 47.000 5552
] PrePren 3080 PPI0D2 300-002 Dielecric 2776 4200 3.000 3000 50.000 2778
6 1400 0.000 1400 1400
FR4 Coro CON0S 400005 FRé 3.000 4200 3000 5,000 60.000 2000
7 1400 0.000 1400 1400
PreFreq 1080 FRIG0T 300001 Dieleciic 1850 4200 3000 3,000 60.000 1850
8 L X W W W W Copperfol FO/01 100001 Copper 0700 5 0.000 0700 0.200
I  Liquid Photoimagesble Mask  SMI0DT 500001 SolderMask 1,000 Gresn 4000

Copper Thickness = 9.1
Stack Up Cost=54.00 |

=9.800 | Dielectric Thickness = 49.650 | Solder Mask Thickness = 2.000 | Stack Up Thickness = 59.460 | Stack Up Thickness with Soldermask = 61.460 |

Structure Name

Target
Impedance

Lower | Upper
Substrate | Subsirate | Lower | Upper Ground | Ground |  Ground. Coating

1 2 Trace | Trace [ Trace | Substate| Subswate| Impedsnce| Ref. | Swp | Swip Stip Above | Trace | Coating

Caloulated | Dielectiic | Dielectric | Width | Width | Separation| 1Height | 2Height | Signal | Plane1| Wicth | Width [ Separation | Substrate | Thickness | Delectric

Impedance [ (Er1) (Er2) W | w2) &1 {H1) H2) Layer | inlayer| (G1) G2y o1y n T (CEn}

Coated Microstnp 16

Edge Coupled Coaled Misrosrip 18 100.000

Edge Coupted Offset Stipline 1814 100.000 101280 4200 4.200 7250 6230 6500 70 128 4 3 0400 0000  0.000 0.000 1400 0.000
Offset Coplanar Strips 1814 50,000 0.000 4.200 4.200 5805 4821 000 27280 13280 4 3 5305 431 482 0.000 1400 0.800
Coated Micrestrip 16 000 78780 4.200 0.000 4500 38500 0.000 €350 0.000 L & 0800  0.000  0.000 1.000 0.700 4.000
Vesen _______________ |Rewsion Mo ol R Ed
SEociated Dasument

160,240 4.200 ©.000 8500 7500 115 £330 0.000 1 3 0000 0000  0.000 1,000 0.700 4,000

75.780 4200 0.000 4500 3500 0.000 350 0.000 1 3 0000 0000  0.000 1.000 0.700 4.000

Page
10X

Pelcr

Speedstack Report Printer toolbar

The Speedstack Report Printer toolbar provides shortcut
access to the most commonly used printing commands.

=L=1"'E RIE

F (=) ==& 00O
1 \,+4% Sy @ D oo (] Display Page |1 s

Use these commands to set up the printer, page orientation
and margins, font size and printing order, select data columns
for display, display or suppress data tables and choose the
on-screen zoom levels. Button functions are described below.
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Send report to printer

Print set up — choose printer, print range, copies

Page set up — orientation and margins

Select stack data columns

Select impedance data columns

=== =ildl i

Select drill data columns

Select BOM data columns

Change font size

|
1 ¥|select stack/drills/impedance/notes print order

Set note field aliases

: Toggle suppress stack data table

E Toggle suppress controlled impedance data table

Toggle suppress drill data table

Toggle suppress BOM data table

@ |2
S S Zoom in/ Zoom out

A
[

Fit page to viewer

nn||Ba

0o Preview one / two / four pages

B

. . ‘| - .
Display Page l—_| D|Sp|ay Pacge select

120 e Speedstack PCB Stackup Builder



Speedstack Report Printer menu system

File menu

Use the File menu under the Printing window to save and
load print settings.

Save Print Settings
Load Print Settings

Exit Ctrl+0O

Whichever settings were last used in a session will become
the default when the Printing window is next loaded.

Options menu

The Speedstack Report Printer Options menu contains all
the settings for printing.

Page Setup

Stack Data Table »
Controlled Impedance Data Table »
Crill Data Table r

Mote Field Aliases
Print Crder
General 4

Restore Default Settings

Page Setup
Page Setup displays the Page Setup dialog to change paper
size and orientation, paper source and margins.

Stack Data Table
The Stack Data Table commands allow for optional display
of stack parameters, drills, thickness totals and tolerances.

Suppress

Stack Data Columns...

Drrills (5tack Table) r
Thickness Totals L
Show Stackup Thickness... 3
Stackup Thickness Tolerance Value »
Stackup Thickness Accuracy k
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Stack Data Columns: select, combine and order the data
columns available for the stack as desired.

= Select Stack Table Columns - B
Selected Columns Available Columns
Descriptian < Supplier M
Type Supplier Description
Processed Thickness » Stock Mumber
Mask Thickness = Min Trace Width
Calor Copper Coverage
r Up Base Thickness
Impedance 1D Finish Thickness
o lsolation Distance
own Tolerance
Resin Content
Delete Tg
Td
" Ink; Thickness
b Data Filenames hd
oK | cancal |

Use the Drills (Stack Table) command to show or hide the
drills in the stackup graphic in the Stack Table.

The Thickness Totals provides optional display of the sum of
materials thicknesses, copper, dielectric, solder mask and
the stackup — with and without the solder mask thickness.

Use the Show Stack Up Thickness command to display or
hide the target or calculated values of total stack thickness.

When the target value of the Stack Up thickness is chosen the
Stack Up Thickness Tolerance values can be displayed as
percentages of the target stack thickness or as actual values.

Choose Stackup Thickness Accuracy to display accuracy by
number of decimal places.

Stackup Thickness Accuracy » 0 Decimal
1 Decimal

2 Decimal

3 Decimal

4 Decimal

Controlled Impedance Data Table
Use the Controlled Impedance Data Table options to show or
hide the controlled impedance structures and parameters.

Suppress

Impedance Data Columns...

Show Structures-by-Layer Separator

Impedance Data columns can be selected for display and
ordered as required. Choose the parameters for display from
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Drill Data Table

the Available Columns pane and change the order of display
using the Up and Down buttons.

= Select Controlled Impedance Table Columns - &

Selected Columns Available Columns

Broadside 2nd Layer

Ref. Plane 2in Layer
Lower Ground Strip Width
Impedance Signal Layer Upper Ground Strip Width
Ref. Plane 1in Layer Trace Offset

Lower Trace Width Up Ground Strip Separation

Structure Image
Impedance 1D
Structurs Name

Upper Trace Width Cl Motes-1
Trace Separation D Cl Netes-2
Target Impedance o Cl Netes-3
Calculated Impedance Cl Notes-4
Tal (+/- %) Delete Cl Notes-5

T

Clear All

oK | Cancel ‘

Within the Impedance Data Table structures can be grouped
by layer; choose Show Structures-By-Layer Separator. The
Separator will add a black structure separator bar on the
print out between structure groups, allowing the structures to
be sorted by layer number rather than the order that the
structures are added to the stack.

Drill DataTable

Use the Drill Data Table command to show or hide the table
of drill parameters and to select and order parameter values
for display.

= Select Drill Table Columns - g
Selected Columns Byailable Columns
Dill Image Fill Type
1st Layer Hole Count
2nd Layer Different Hole Sizes
Column Position Minimum Size
Ciill Type Data Filenames

Up
Down
Delete

Clear All

|

oK \ Cancel \

Use the Sort Drills... command to order the drill table — drills
can be sorted by start-end layer order or creation order

* Suppress

Drrill Data Columns...
Sort Drills... k Creation Order
Start - End Layer Crder
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Bill of Materials Table

Speedstack’s Technical Report incorporates the Bill of
Material (BOM) table with the stock-number displayed
optionally as a barcode. The table contains fields for Total
Quantity (No. Panels * Stack Quantity) and Total Cost (Unit
Cost * Total Quantity.)

Supplier Stack Total

Suppli Deseripti Description Type Stock Number | Quantity | Unit Cost| Stack Cost| Quantity | Total Cost
Falar Samples SM00T  Liquid Phowimageable Mask  SeiderMask  ||IIIEANININ 2 0,00 0.00 2 0.00
Folar Samples FO/001 Copper Fail Copper || || || ||| |||| 2 i} 2.00 2 2.00
Polar Samples PP/O01 PrePreg 1080 oietectic NI 2 0 200 2 2.00
Folar Samples [Walili] FR4 Core FR4 || || || ||| |||| 2 5.00 10.00 2 0.00
Polar Samples PPO0Z PrePreg 3080 cietecric NI 2 2,00 400 2 4.00
Falar Samples FPI004 FreFreg 1651 Dielectric | || || ||| || || 4 4.00 16.00 4 15.00
Polar Samples cO/mo20 FR4 Core Fra IR 1 20,00 20.00 1 20.00
24,00 =4.00

Ho, of Panele = 1 | Cweuns Per Panel =1 | Phnes Per Cweut = 54 .00 |

The table includes totals for the Stack Cost and the Total
Cost columns.

A summary section presents 3 values: No. of Panels, Circuits
Per Panel and Price Per Circuit. The No. of Panels and
Circuits Per Panel can be entered by the user at any time or
optionally at the start of each print session.

From the Options menu choose B.O.M. Data Table |

Panels / Circuits per Panel...

B.O.M. Data Table > Suppress

Stock Mumber >

Panels / Circuits per Panel...

— O >
Enter the following data required for the Bill of Materials
[EOM] table.
MNumber of Panels ﬁ]
Circuits per Fanel |1

[ Always show this at the start of a print session
Okay |

Price Per Circuit is a calculated value (Total Stack Cost /
Circuits Per Panel).
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B.O.M. Data Table

Bill of Materials Table columns can be selected for display
and ordered as required. Choose the parameters for display
from the Available Columns pane and change the order of
display using the Up and Down buttons.

o= Select Bill of Matenals Table Columns — Oa =

Selected Columns Ayailable Columns

Supplier

Supplier Description
Description

Type

Stock Mumber
Stack Quantity Up
Unit Cost
Stack Cost
Total Quartity
Total Cost

Down

Delete

(st

Clear All

oK ‘ Cancel |

From the Options menu choose B.O.M. Data Table to display
or suppress the table. The Suppress command toggles the
B.O.M. table on and off in the report.

Suppress

Stock Number » | v Show as Barcode

Panels / Circuits per Panel... Barcode Font and Start/Stop Character...

Stock numbers can be displayed in alpha-numeric form or as
barcodes. Choose Stock Number|Show as Barcode to toggle
the Stock Number display between barcodes or alpha-
numeric text.

Stack
Description Type Stock Number | Quantity | Unit Cost
Liquid Photolmageable Mask  SoiderMask ||| 2 0.00
CopperFoil - Copper | [N 2 100
PrePreg 1080 Dietectric [ I} 2 100
FR4 Core FRa IR0 2 500
PrePreg 3080 Dielectric ||} 2 200
PrePreg 1651 Dielectric [ I 4 4.00
FR4 Core FRa IR T 2000
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Choosing the bar code font

From the Stock Number command choose Barcode Font and
Start/Stop Character. The Select Barcode font and Start/Stop
Marker Characters dialog is displayed.

8 -
Aharoni )

Algerian : 10

Andalus 11

Angsana New

AngsanalJPC 13

Aparajita 14

Arabic Typesetting 15

Azl 16

Arial Black % 17 %
3 of 9 Barcode 12

Include Stop / Start Character
" None

* Asterisk -~
" Exclamation - !
" Other

[4]
Reset Close

Choose the font and font size and the start / stop character
as appropriate. (The barcode font must already installed on
the host computer.)

Choosing the start/stop character

The Start/Stop character is a requirement for certain barcode
types such as Code 39 (also referred to as Code 3 of 9,
Code 3/9, Type 39, etc.) The Code 39 asterisk character is
normally reserved as a start/stop character rendering the
data a valid barcode.

As an example, if the Stock-Number is 123-456, selecting
the Asterisk option will add enclosing asterisks to the Stock-
Number so that the barcode is valid. (In some instances
asterisks may already be included in the Stock-Number in
which case choose the None option.) There are other
situations where another character may be used. Exercise
caution when determining the appropriate font choice and
start/stop character to use. In the event that an inappropriate
font is chosen, the results may be unpredictable.

Note Field Aliases

Note Field Aliases allows for the free-text note fields (for the
Stack and Controlled impedance tables) to be given
descriptive names.
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Print Order

Use the Print Order dialog to move the Controlled
Impedance Table, Drill Tables and Notes sections up or
down within the report.

Print Order = B

Stack / Materals Data
Controlled Impedance Data
Crills Data

Notes Down

i

Close

Note: the Stack/Materials data Table cannot be reordered
and must remain the first item in the print order.

General options
Use the General Options to specify

Polar Logo 3
User Logo L
Copyright 3
Data Mumber Format 4
Data Alignment 3
Stack Alignment (Flex-Rigid only) ]
Font Size r
Colours

File Path 3
Margin Guides 3

Polar Logo: toggles on and off the Polar Instruments logo.

User Logo: toggles on and off the user-defined logo (as set
in the application configuration).

Copyright: toggles on and off the copyright information and
allows copyright test to be edited.

Data Number Format: sets the precision of numeric data in
the printout.

Data Alignment: specifies alignment (left, centre, etc.) for
stack, impedance and drill data.

Stack Alignment (Flex-Rigid only): — Align to Master Stack
allows the vertical position of sub-stacks (printed on separate
pages within the report) to be preserved with respect to the
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master stack; Align to Page Top presents each sub-stack at
the top of each page.

Colours: allows for the colours of items within the report to be
customised. Click Override Default Colours and Change to
specify the new colour. Click Reset All to return to the default
colours.

File Path: toggles on and off the file path/file name

Margin Guides: toggles on and off boundary markings (in the
user selected units.) These match the Speedstack units
selected within the Stackup Editor | Units menu.

The margin guides allow for display of the printable area of
the page — which can vary depending upon the device —
even though the page size remains the same. (With some
devices the report cannot use the full extents of the page.)
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Appendix A

o A-1



